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1. Introduction

Welcome to Tailor 2.0 for Mac OS, the premier desktop PostScript tool. Tailor al-
lows click-and-drag manipulation and full editing of any object in a PostScript
file, and always generates clean PostScript with correct DSC comments. Version
2.0 offers a range of new attractive features, such as improved font handling, sup-
port for OPI links, OPEN awareness, export to PDF and rendering to several
bitmap formats.

1.1. Structure of this manual

This manual is organized in three parts.

Getting Started

�Getting Started� contains installation instructions, and explains how Tailor can
be used in your work. Seasoned Mac OS users will benefit from reading the chap-
ter �Quick Start for Experienced Users�.

User Guide

The �User Guide� contains information on how to perform specific tasks in Tailor.
A number of more advanced topics, such as font handling, are covered in some
depth as well.

Reference Manual

The �Reference manual� contains a description of all Tailor functions, including
menu commands, inspector panels, and keyboard shortcuts.

1.2. How to contact us

We welcome and value all problem reports, ideas and suggestions. If you have the
choice, we prefer electronic mail above other media. Feel free to send us (prefera-
bly small) sample files as MIME compliant attachments.

EnFocus Software NV
Technologiepark-Zwijnaarde 3
I.I.C. Building
B-9052 Zwijnaarde, Belgium
Voice: +32 9 241 57 05
Fax: +32 9 245 03 04
Email: info@enfocus.be
WWW: http://www.enfocus.be

EnFocus Software Inc.
234 Columbine Street, Suite 300B
Denver, CO 80206
Voice: 1 303 393 7282
Toll free: 1 888 EnFocus
Fax: 1 303 393 7290
Email: info@enfocus.com
WWW: http://www.enfocus.com
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2. Installation

2.1. Distribution kit

This version of Tailor is distributed as three separate self-extracting archives.
They may have reached you on floppy disk, on CD-ROM or via the Internet.

♦ Tailor 2.0 PPC 68K.sea contains a fat binary that will run on PowerPC and on
any 68K based Mac OS computer (68020 or higher).

♦ Tailor 2.0 PPC 68KFPU.sea contains a fat binary that will run on PowerPC
and on any 68K based Mac OS computer that has a hardware floating point
unit.

♦ Tailor 2.0 Doc.sea contains the on line documentation and sample files.

2.2. Installing Tailor

To install Tailor on your system, you need to select two out of the three supplied
archives based on the type of your Mac OS computer:

♦ PowerPC: Tailor 2.0 Doc.sea and Tailor 2.0 PPC 68KFPU.sea.
♦ 68K based with FPU: Tailor 2.0 Doc.sea and Tailor 2.0 PPC 68KFPU.sea.
♦ 68K based without FPU: Tailor 2.0 Doc.sea and Tailor 2.0 PPC 68K.sea.

Install the two appropriate archives by consecutively double clicking them. You
will be prompted for a destination folder.

2.3. Licensing Tailor

After you installed Tailor on your computer as described above, it will run in
demo mode. In this mode Tailor is fully functional except for the export functions
(i.e. you can�t save nor print files).

If you have purchased Tailor, you will have received a license string. To register
your license string and enable Tailor�s functions, perform the following steps:

♦ Launch Tailor. Since Tailor is in demo mode, it brings up the Preferences
Panel showing the Licensing pane.

♦ Type your name and (optionally) the name of your organization.
♦ Enter your license string, in the form LLLLLLL-LLLLLLL, where L stands

for a letter. There are two sets of 7 characters, separated by a hyphen. En-
tering the string is not case sensitive. You don�t have to enter the serial num-
ber (a 5-digit number); it is encoded in the license string.
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♦ Press the Accept & Register button. Note that, by registering your license
string, you accept the terms of the License Agreement listed in the Reference
Manual.

If you have entered the license string correctly, Tailor will change the appearance
of the Licensing pane to reflect the type of license you have purchased and the
serial number of your software copy.

    

The Licensing pane before and after registering

For a description of the different types of licenses, see Getting Started, Tailor fla-
vors on page 17.

2.4. Viewing the on line documentation

You can view the on line documentation with any viewer that supports html. This
includes the well-known web browsers such as Netscape Navigator or Microsoft
Internet Explorer.

In case you don�t have such a viewer at your disposal, we deliver a basic html
viewer with Tailor. You can find it in the Documentation folder. By double click-
ing the �help.html� file this viewer will be launched and you will see the �Tailor
Help Contents� page.

The html viewer is property of:

Sassafras Software Inc.
P.O. Box 150
Hanover, NH 03755-0150
USA
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We got their kind permission to distribute the viewer together with our software
to view the documentation. For more information about the html viewer, please
contact Sassafras Software Inc. at kurash@sassafras.com.
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3. What is Tailor

Tailor allows click-and-drag manipulation and full editing of any object in a Post-
Script file, and always generates clean PostScript with correct DSC comments.

Used interactively, Tailor is a true visual PostScript editor. Simply click and drag
to manipulate and edit any object in a PostScript file, to preview and correct de-
tails at a high zoom factor, to replace a typeface, or to apply last minute changes.

Used in the background, Tailor becomes an automated PostScript cleaner. Files
processed through Tailor fully conform to the Document Structuring Conventions
(DSC 3.0), are �normalized�, and have been stripped of all unnecessary overheads.
Alternatively, Tailor can convert PostScript to a number of export formats.

Tailor supports OPI, preserves embedded fonts, recognizes spot colors, supports
multi-page documents, and is Luminous OPEN aware. It reads both PostScript
and EPS files. Export formats (in addition to PostScript) include EPS with Mac or
PC preview, PDF, Illustrator 3, and a number of bitmap formats.

3.1. A visual PostScript editor

Tailor allows you to visually edit virtually any PostScript or Encapsulated Post-
Script (EPS) file. Once opened, the file appears on the screen in wysiwyg (what
you see is what you get) form.

    

The Tailor toolbox and a document window

You can now manipulate any object by using familiar editing tools like the selec-
tion arrow. Drag selected objects with the mouse to move them, or transform
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them using special transformation tools (rotate, scale, shear). There are also tools
to add objects such as text, boxes, circles and paths. You can browse the pages of a
multi-page document and remove, add or reorganize pages.

Tailor requires absolutely no knowledge of the PostScript language. If you are
familiar with any graphic-editing program, you will immediately feel comfortable
with Tailor.

Tailor contains a full PostScript interpreter. It even lets you edit hand written
PostScript code or PostScript graphs generated by specialized scientific or
mathematical programs.

3.2. A PostScript cleaner

Files processed through Tailor fully conform to the Document Structuring Con-
ventions (DSC 3.0), and they contain very �clean� PostScript. This ensures that
the files will render correctly, without late-stage PostScript errors. Additional
benefits include faster processing by and increased compatibility with trapping
and impositioning solutions further down the workflow.

Tailor can be set up to clean sets of files in batch using �Tailor Converter�, a sam-
ple AppleScript included in the distribution kit. Furthermore, Tailor is Luminous
OPEN aware, so it can be placed in an OPEN pipeline to perform automated
background processing.

3.3. A format converter

Tailor allows you to convert PostScript files as well. For instance, you can open a
PostScript file, select an illustration from page 9 and save it into an EPS file. You
can also convert any EPS file to PostScript. Tailor makes this an easy one-step
process.

When saving a document you can select several graphic file formats:

♦ Tailor�s �native� formats are PostScript and EPS (with low-resolution pre-
view).

♦ �Compatibility� formats include Adobe Acrobat PDF and Adobe Illustrator 3.
♦ Pixel image formats include PICT, TIFF and GIF.

Alternatively, you can extract the text from a PostScript file to edit it in your
word-processor. You can save the text as plain text (ASCII) or as formatted text
(Rich Text Format). Saved as formatted text, paragraph information and most
typographic attributes are preserved.
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3.4. How Tailor helps you become more productive

Make last minute changes

In case you regularly receive PostScript or EPS files from external sources, this
feature is an immense time saver. Example: you receive an EPS illustration that
uses a font you do not have on your system. The font must thus be changed. With-
out Tailor you would have to send back the EPS file and wait for the designer to
change it and send it back. With Tailor, you just open the job. Tailor will let you
know that it didn�t find the font, and substitute the font by a default font. Using
the Graphic Inspector, you can easily change the font and perform any necessary
realignment of the text to cope with the changed character widths.

Enhance and transform EPS pictures

Many word processing and page layout applications allow you to place EPS files.
Some of those applications allow you to scale, crop or rotate EPS images. None of
them allows you to change an EPS image.

Tailor gives you complete freedom in matching EPS pictures to your document.
Some examples of what you can do with Tailor:

♦ Change the colors in the EPS picture to match the colors used in your docu-
ment

♦ Rotate the whole EPS image by any angle
♦ Rotate a text line within the EPS image by any angle
♦ Apply a rectangular or non-rectangular mask to the image

Fix PostScript problems

Tailor generates clean PostScript that conforms to the Document Structuring
Conventions (version 3.0). It will do so even if the original file was not DSC-
compliant. Some programs, such as imposition packages, require DSC-compliant
PostScript to function properly. You can turn questionable PostScript to clean
PostScript just by loading it into Tailor and saving it. You can even automate this
process! See User Guide, Using Tailor Converter on page 68.

Extract illustrations from PostScript files

Using Tailor�s Copy and Paste functions you can extract graphical objects from a
PS or EPS job, such as text, filled or stroked paths or even whole groups. You can
paste the result into a new Tailor document. You can then save this new docu-
ment as PostScript, EPS or Adobe Illustrator 3.
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Extract formatted text from PostScript files

Using the Save As command on the File menu, you can export a text column as
formatted, flowing text that can be imported into a word processor. Paragraphs
are automatically recognized, and most typographic attributes are preserved.

Add objects to a PS or EPS job

Tailor provides the necessary tools to create lines, curves, boxes, ellipses and text
lines. Once created, these objects are indistinguishable from original objects, and
you can edit their attributes using the Graphic Inspector.

You can also paste a PICT into your document. It will be inserted into the Post-
Script job as a regular pixel map.

Convert PostScript and EPS to other formats

Using Tailor you can convert PostScript to EPS (with preview image) or Adobe
Illustrator 3 format, and EPS to PostScript.

Likewise, you can use Tailor to convert PostScript or EPS to the popular formats
for on line publishing. These include Adobe Acrobat PDF and several pixel image
formats such as TIFF and GIF.

View and change graphic attributes

Tailor�s powerful Graphic Inspector allows you to view and change the graphic
attributes of any object, for instance its color, line thickness, text font, etc. You
can change position and transformation attributes using the mouse, or numeri-
cally using the Graphic Inspector.

Check PostScript jobs

Tailor scans a PostScript file and gives a clear and complete report of the Post-
Script errors that occurred. If a PostScript file passes through Tailor without er-
rors, it will very likely print or expose without errors.

In addition to detecting errors, Tailor allows you to view any page, even in detail
by using Tailor�s magnified viewing modes.

3.5. What sets Tailor apart from other graphic editors

Designed to support the PostScript imaging model

Some applications provide import filters for PostScript. However, these applica-
tions were not originally designed for PostScript editing. When you import a
PostScript job into such a program, some object attributes or even the objects
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themselves may be changed or even get completely lost. Typical for these applica-
tions is that they can import only the first page of a PostScript file.

Tailor was designed for PostScript editing. It implements nearly all PostScript
object types and attributes. And it supports multi-page PostScript documents as
well.

Tailor recognizes PostScript structure

A unique feature of Tailor is that it recognizes grouping structure in PostScript
files.

Many jobs contain embedded EPS illustrations. When reading input, Tailor rec-
ognizes illustrations and puts each one in a separate group. You can then ma-
nipulate the illustration as a whole (select, move, transform it), or you can enter
the group and edit its contents.

Structure recognition is not restricted to embedded EPS illustrations. Sequences
of objects having the same mask are also automatically grouped into a group with
mask.

Powerful group navigation tools

In most applications that support grouping, you must break a group before you
can change its contents. After editing, you must recreate the group again. This is
laborious and error prone.

Tailor allows you to enter a group without destroying it. When you enter a group,
all objects outside the group are grayed so that you see exactly what�s in the
group. Grayed objects are �locked�, so you cannot accidentally select or modify an
object outside the group. Navigation up and down the grouping hierarchy is very
easy using the grouping level buttons in the window toolbar.

A special Group selection arrow in the Tailor Toolbox allows you to select any ob-
ject regardless of its grouping. This is called group transparent selection. It�s a
great time saver if all you want to do is change a particular object regardless of
whether it is part of a group or not.

Floating property windows (Inspectors)

The Document Inspector shows information related to the whole document such
as the page size. It also shows any PostScript errors that may have occurred dur-
ing interpretation of the input file and during saving of the job. The Document
Inspector pops up automatically during opening and saving when Tailor detects
an error.
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The Graphic Inspector showing the attributes for a stroked path

The Graphic Inspector shows the type of selected object(s) and all relevant
graphical attribute. The Graphic Inspector contains multiple panes allowing you
to view and modify sets of attributes such as position, graphic attributes and sta-
tistics. For embedded EPS illustrations the inspector shows useful information
such as the name of the EPS file and even the name of the application that cre-
ated it.

3.6. Limitations

Pre-separated PostScript files

Tailor does not support editing of pre-separated PostScript files. After processing
a pre-separated PostScript file through Tailor, each separation is saved as an in-
dependent page, and all information on the relation between the separations is
lost.

Also, Tailor does not support DCS. Note: do not confuse DCS with Adobe�s Docu-
ment Structuring Conventions (DSC) which are of course supported by Tailor.

Screen frequency and angle

After processing a PostScript file through Tailor, screening parameters such as
frequency and angle are lost. This means the resulting file will be printed/exposed
using the default screening parameters as provided by the output device�s RIP.
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Calibrated colors

Tailor does not support calibrated colors (i.e. device-independent color spaces).
After processing a PostScript file through Tailor, color profiles are lost and cali-
brated colors are replaced by (arbitrary) device dependent colors.

Patterns

Tailor does not support PostScript level 2 patterns. All level 2 patterns are re-
placed by solid 50% gray.

Composite fonts

Tailor does not support composite fonts (2-byte fonts, used to represent the large
character sets in Asian languages). PostScript files with text in a composite font
cannot be correctly opened in Tailor.
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4. New features in Tailor 2.0

Tailor 2.0 for Mac OS offers an impressive list of new features and improvements.
Some of the most important ones are discussed below.

Flavors

To address the needs of particular market segments, Tailor 2.0 is available in dif-
ferent �flavors�. All flavors are based on the same binary. Differentiation between
flavors is done at run time, using a license string mechanism. For more informa-
tion, see Getting Started, Tailor Flavors on page 17.

Fonts and text editing

Tailor 2.0 supports PostScript files with embedded TrueType fonts by converting
the text in those fonts to outlines (previously, those files could not be imported
correctly). Furthermore, Tailor 2.0 correctly handles characters that are not pres-
ent in the Mac encoding vector (previously, these characters were replaced by a
space). These enhancements are particularly important for processing PostScript
files generated on Windows.

The new font picker showing the attributes for an embedded font

The totally renewed font picker now separately lists font family, style and attrib-
utes. In addition to the available system fonts, the picker manages any embedded
fonts extracted from PostScript files. Each unavailable font can be individually
assigned a substitution target, and those font substitution relations are remem-
bered between sessions.

OPI

Tailor 2.0 supports Open Pre-press Interface comments conforming to the major
standards (OPI 1.3, OPI 2.0, Luminous Color Central, and Helios EtherShare).
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The graphic inspector showing the attributes for an OPI group

An OPI image is shown as a special �OPI group�, with preview if it is available in
PostScript. The OPI group can be resized and moved as usual. The graphic in-
spector allows re-linking the file path for the OPI image and modifying the crop
rectangle.

Automation

Tailor 2.0 is compatible with Luminous OPEN (�OPEN aware�). Placed in an
OPEN pipeline, Tailor becomes an automated PostScript cleaner.

Import

General PostScript compatibility is substantially improved since the previous ver-
sion. Importing paths (line-art) has become considerably faster.

Export

Tailor 2.0 can LZW-compress pixel images in exported PostScript and EPS files,
resulting in much smaller output file sizes.

EPS files can be saved with PC-TIFF preview as an alternative for the Mac-PICT
preview format. Moreover, Tailor 2.0 ensures compatibility with PhotoShop when
saving a (non-compressed) pixel image as EPS.

New export formats include Adobe Acrobat PDF and the pixel image formats
PICT, TIFF and GIF. Publishers can thus convert PostScript or EPS files to the
popular on-line formats.
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Memory Management

Tailor 2.0 provides virtual memory on a page by page basis. You can therefore
handle documents with many pages using only a reasonably small memory alloca-
tion.
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5. Tailor flavors

To address the needs of particular market segments, Tailor is available in differ-
ent �flavors�. All flavors are based on the same binary. Differentiation between
flavors is done at run time, using a license string mechanism.

Demo

The �demo� version of Tailor requires no license string. All import and edit func-
tionality is enabled; all export (save, print) functionality is disabled. The demo
version may be distributed freely.

Preview+

This low-cost flavor allows previewing and printing PostScript in a regular office
environment. It is shipped electronically, or on floppy disk for an extra handling
fee. There is no packaging and no printed manual.

Feature set: import PS and EPS; preview imported files with fast zoom; random
access to pages; wireframe mode; adjust page size & orientation; adjust position of
complete page contents on the page, print or save to PS, save to PDF.

Limitations: cannot save to EPS or any of the other formats (illustrator, bitmaps,
text); does not allow editing except for page size adjustments; does not support
spot colors (spot colors are automatically converted to CMYK); does not support
OPI (OPI comments are removed); does not support automated operation (no Ap-
pleScript or OPEN support).

Target: users in a general office, academic or publishing context who want to view
and print PostScript files received from third parties, or downloaded from the
Internet.

Publish

This flavor includes all import, edit and export functionality, but lacks some of the
high-end features.

Limitations: does not support spot colors (spot colors are automatically converted
to CMYK); does not support OPI (OPI comments are removed); does not support
automated operation (no AppleScript or OPEN support).

Target: in-house publishing departments, copy shops, printing-on-demand shops,
pre-press and repro service bureaus, on line publishers. These users need to com-
bine art and text received from third parties into a complete page layout. Tailor
Publish serves as a general tool to correct problems with colors or fonts, to extract
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text or graphics from a multi-page PostScript document, or to convert PostScript
to another format such as PDF or bitmap.

Workflow

This flavor includes all available functionality. The differentiation between Pub-
lish and Workflow flavors will gradually become bigger in future Tailor versions,
as more high-end features will be added.

Target: professional pre-press users, including service bureaus and in-house pub-
lishing departments. These users need support for OPI and spot colors, and will
benefit from Tailor Workflow�s automated operation capabilities.

Academic

This flavor has the same functionality as the Publish flavor, but is priced differ-
ently. It may be sold to academic users only.

Target: researchers at universities and related institutes who produce publica-
tions or presentations. Benefits are similar to those described for Tailor Publish.
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6. Quick start for experienced users

This chapter provides a quick tour of Tailor. It assumes that you are familiar with
Mac OS and that you can work with a graphic arts application such as a desktop
publishing program or a drawing program.

6.1. Opening and saving

Tailor behaves a lot like other graphic programs. You can open, view and edit
PostScript and EPS files using familiar commands and dialogs. Browsing the
menus, toolbars and dialogs will take you a long way.

Opening a document is done as usual. In the Open Panel, Tailor lists only files
that have the default file type for PostScript or EPS documents (�TEXT� or
�EPSF�). However, when you drag a document over Tailor�s application icon, it
will be opened regardless of its file type.

When saving the document you can select several graphic file formats:

♦ Tailor�s �native� formats are PostScript and EPS (with low-resolution pre-
view).

♦ �Compatibility� formats include Adobe Acrobat PDF and Adobe Illustrator 3.
♦ Pixel image formats include PICT, TIFF and GIF.

Options for each of these formats can be set using the Preferences Panel.

Alternatively you can save a text column as plain text or as formatted, flowing
text that can be imported into a word processor. Paragraphs are automatically
recognized, and most typographic attributes are preserved.

The Document Inspector informs you of the status of loading and saving. Tailor
lists any errors or warnings that occurred, and the number of times they occurred.
An error during opening does not necessarily mean that the document is unus-
able. For instance, if a font is missing, Tailor automatically substitutes a replace-
ment font.

6.2. Toolbox and Window Toolbar

The floating Toolbox contains selection, transformation and drawing tools. Most
tools behave as expected.

The second selection tool called the group transparent selection tool  is ex-
plained in the section on grouping below.

The Window Toolbar provides the following functions:
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♦  selection of view scale

♦    zooming in and out

♦  toggle between wireframe and preview viewing mode

♦   enter and exit a group; see the section on grouping

♦  indicator of current group level

♦  page navigation tools

6.3. Grouping

When reading a file, Tailor attempts to preserve as much structural information
as possible. For instance, it detects embedded EPS images and creates a group
containing the objects of the image. This makes it very easy to operate on the im-
age as a whole.

Tailor allows you to edit the contents of a group without ungrouping it. Select the
group and double click it, or use the enter group button  on the window toolbar.
All objects outside the group are grayed. You can now select and edit objects in-
side the group. To leave the group, use the exit group button  on the window
toolbar.

A group can have a mask or clip path. You can view and edit this mask by select-
ing wireframe mode. Masks display in a special color.

If you use the group-transparent selection tool  in the Toolbox, you can select
any object regardless of its group level. If the object is in a group (even in a nested
group), Tailor will automatically enter the group. You can exit from the group by
using the exit group button or you can simply select another object.

6.4. Editing

The Toolbox gives you access to the familiar editing tools to move, scale, rotate,
shear or delete an object using the mouse.

The Graphic Inspector is a floating dialog with multiple panes. The information
shown depends on the selected object(s). All information such as color and line
width can be changed. The attributes shown are the PostScript graphic state at-
tributes as defined in the PostScript language definition.

You can also use the Graphic Inspector, Position pane, to move or transform ob-
jects numerically.

Copy and paste operations work inside Tailor, as you would expect. In addition,
you can paste a PICT image (copied from another application such as a screen
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grabber) into a Tailor document. The PICT is inserted into the document as a
regular pixel image.

You can also copy a column of text in Tailor and paste it into a word processor,
conserving paragraphs and most typographic attributes if the word processor
supports pasting styled text.

6.5. Printing

Tailor can print to PostScript printers only. Remember that Tailor is a PostScript
editor.

To change a document�s page size or orientation (landscape/portrait), use Tailor�s
Document Inspector, Page Size pane. The size and orientation set in the Page
Setup panel do not affect the Tailor document; they only specify the physical me-
dia to be used by the printer.

The other options in the Page Setup panel (N-up, scaling, etc.) and those on the
Print panel (paper source, printer settings, etc.) should work as expected.

Do not use Tailor�s Print command to save PostScript to a file. Printing �to a file�
results in ill-behaved PostScript that may not correctly print on other printers.
Instead, use the regular Save or Save As commands, which produce well-behaved,
portable PostScript.
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7. Frequently Asked Questions

1. Rectangle selection selects too many objects

The default action of drag selection is to select all objects partially or completely
inside the selection rectangle. To limit the selection to the objects falling com-
pletely within the rectangle, press the Option key as you drag.

2. Rectangle selection of objects on a large background object doesn�t work

Clicking the mouse once already selects the background object, preventing you to
drag select. There are two solutions:

♦ Hold down the Command key and the Option key while selecting. The Com-
mand key will force rectangle selection. Pressing the Option key will ensure
that the background object itself is not selected.

♦ Go into wireframe mode, then perform your selection.

3. I can�t select the object I want to select

There are a number of possible reasons why the selection tool doesn�t work as you
expected it to:

♦ The object is inside a group and you select the whole group when you try to
select the object.
Solution: double click on the object to enter the group. The objects outside the
group become dimmed. Now select the object you want. As an alternative you
can select the object directly by using the group transparent selection tool

.
♦ You have entered a group and the object you want to select is outside that

group. All objects outside the current group are shown dimmed (grayed) but
this could be hard to see in some documents.
Solution: exit the group you are in by choosing Exit Group from the Edit
menu or pressing the exit group button  on the Window Toolbar until the
object you want to select isn�t dimmed anymore. As an alternative, use the

group transparent selection tool  to select the object.

4. A font size or other measurement doesn�t seem exact

For example, the Graphic Inspector shows a font size of 23.96 for a 24-point font.

The reason is that some applications are not very accurate and introduce round-
ing errors during PostScript generation. Tailor operates in high precision and it
reproduces very accurately what�s in the PostScript file - correct or not.
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5. The object I just created does not display

Probably you have created the object while being inside a group with mask and
you placed the object completely outside the mask. Move the object into the mask.
If you have accidentally created the object within the group then cut the object,
exit from the group and paste the object in the desired group.

Tip: use wireframe mode to find �lost� objects (click on the  button on the Win-
dow Toolbar).

6. Tailor fails to start when I double click a PostScript or EPS file in the Finder

The Finder keeps a record of the application that created a file. If you double click
a file and Tailor doesn�t start, this probably means that the file was created by a
different application. To overcome this problem simply drag and drop the file you
want to open on Tailor�s icon.

Note: you can tell if Tailor is the creator of a file by looking at the icon used to
represent the file by the Finder. If this is the Tailor document icon, Tailor will
start when you double click the file.

7. Tailor gets out of memory

There are a number of things you can do to reduce memory consumption:

♦ Limit the number of opened documents.
♦ Avoid working with fonts that are not installed on your system. Using embed-

ded font information or text outlines consumes considerably large amounts of
memory.

♦ Reduce the maximum number of undoes (Preferences Panel, Editing pane).
Note that this setting only effects documents opened after the change has
been made.

♦ Avoid keeping large objects (such as pixel images) on the clipboard. To clear
the contents of the clipboard, select a simple object (such as a rectangle, or
short text segment) and choose the Copy command.

Alternatively, you can increase the size of Tailor�s memory allocation. For more
information on Tailor�s memory management, see User Guide, Understanding
memory management on page 75.

8. Some text looks funny and the display refreshes slowly

To display text in regular portrait or landscape orientations, Tailor uses bitmaps
acquired from Quickdraw (i.e. the Mac OS). This ensures that the characters are
optimized for screen display, using all the tricks that font designers and system
programmers have provided. However, in a number of cases, Tailor cannot use
these bitmaps. It then has to paint the text by filling the appropriate character
outlines, which is less readable, especially at small sizes.
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Text will be painted using outlines as described above in the following situations:

♦ The text is rotated, sheared or stretched.
♦ The text is larger than about 130 pixels, either because you use a large point

size or you zoomed in on your document.
♦ The text is put in a font that is not available on your system but that was em-

bedded in the input file. For a detailed explanation of this situation, see User
Guide, Understanding font handling on page 61.

9. The font picker doesn�t show all fonts on my system

Tailor can only work with scalable TrueType and Adobe Type 1 fonts. Further-
more, there are a number of font types that aren�t supported by this version of
Tailor. Thus, fonts of the following types will not appear in the font picker:

♦ Bitmap fonts: these fonts cannot be scaled for printing.
♦ Multi-byte fonts: fonts with large character sets (such as Chinese or Japanese

fonts).
♦ Adobe Multi-Master fonts, including masters and specific font instances.
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8. Working with Documents

8.1. Working with PS and EPS files

Most word processing and desktop publishing applications have their own (native)
data format for documents. Generally this data format is specific to the applica-
tion. Some applications have import filters to read files from other applications.
These import filters are not perfect though; some information may get lost when
importing a file.

The native data format of Tailor is PostScript, in two forms: Pure PostScript (ab-
breviated PS) and encapsulated PostScript (abbreviated EPS). Tailor can open a
PostScript or EPS file, and it can save a document as PS or EPS.

Working with PostScript files

PostScript files are mainly used as print files, i.e. files obtained by �printing to a
file�. You can print to a file from almost any application that has a Print com-
mand.

To generate a PostScript file from your application

Just choose Print from the File menu and the print panel will appear. In this
panel you will either find a checkbox that says �Print to PostScript� or you will be
able to choose PostScript from a list. Remember to choose general PostScript
(don�t choose PostScript for a particular printer).

If you select a regular printer, the resulting PS file will be a composite color file;
i.e. it contains all the colors of your original document. If you select a device that
works with separations such as an image setter, the resulting PS file may be a
separated file. Normally you should work with composite files unless you specifi-
cally wish to generate separations. Note that the current version of Tailor does
not work with separated PostScript files.

Although you can print to file from Tailor as well, you should not use this tech-
nique to generate PostScript files. Printing to file generates ill-behaved PostScript
that may not print on other printers. Instead, use the regular Save or Save As
commands, which produce well-behaved, portable PostScript.

Multi-page PostScript files

A PostScript file can contain a single page or multiple pages. When you open a PS
file in Tailor, Tailor reads all pages. When you save the document in PS format,
Tailor writes all pages to the output file.
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Working with EPS files

An EPS file is intended for exchanging graphic data such as illustrations between
applications. An EPS file consists of two sections:

♦ A preview section used to visualize the EPS file in the application in which
you place it. The preview image generally has a low resolution and is not edit-
able.

♦ A PostScript section that contains the high-resolution data. An application in
which you place an EPS file does not read or interpret the PostScript section.
It just inserts it into the PostScript print file when you print the document.

Tailor allows you to open any EPS file. In contrast to other applications, Tailor
reads the PostScript section rather than the preview section. In that way you
have full access to the high-resolution data.

When you save the EPS file from Tailor, Tailor recreates the preview section, re-
flecting any edits that you may have performed.

An EPS file always contains a single image. Using Tailor you can save any EPS
illustration in either PS or EPS form. You can save a PS document in EPS format,
but only a page at a time (to automate this procedure, see User Guide, Using
Tailor Converter on page 68).

Working with Adobe Illustrator files

With Tailor you can open an Adobe Illustrator file, but only if it was saved from
Illustrator with the EPSF header included (this is an option you can choose in Il-
lustrator when saving the file).

Tailor allows you to save any document in Adobe Illustrator 3 format. Be aware,
however, that you won�t be able to read the file back into Tailor: Tailor does not
include the EPSF header. If you want to read the document back into Tailor, save
it as PostScript or EPS in addition to saving it in Illustrator format.

8.2. Opening and saving documents

To open a document

There are three ways to open a document in Tailor:

♦ Start Tailor; choose Open from the File menu. In the Open File dialog, select
the desired folder. Tailor shows all PS and EPS files in the selected folder (see
note below). Double click the desired file, or click the file and press the Open
button.
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♦ If the file was created by Tailor, double click the PostScript or EPS file you
want to open in the Finder, or select the file and choose Open from the
Finder�s File menu. Tailor will open the file. To ensure the file was created by
Tailor, look at the file�s icon. It should be Tailor�s icon.

♦ In the Finder, select the file(s) you want to open and drag them to Tailor�s
icon. When the icon highlights, release the mouse button. Tailor opens all
dragged files.

Note: In the Open File dialog, Tailor lists only files that have the default file type
for PostScript or EPS documents (�TEXT� or �EPSF�). However, when you drag a
document over Tailor�s application icon, it will be opened regardless of its file
type.

To verify if the file has loaded successfully

While reading the PostScript file, Tailor performs error checking. Many things
can go wrong in a PostScript file: PostScript language errors, missing fonts, etc. If
Tailor detects an error, it reports the error in the Document Inspector.

The Document Inspector automatically pops up and Tailor gives a warning beep
to make sure errors get noticed. The Document Inspector lists all errors and the
number of times they occurred during import.

Document Inspector listing import messages

To open multiple documents

You can open more than one document at a time. Each time you open a document,
Tailor creates a new document window and displays the document in this window.
The number of documents you can open simultaneously depends on the amount of
available memory and the complexity of the documents. When Tailor gets out of
memory, see Getting Started, Frequently Asked Questions on page 22.

To close a document

Choose Close from the File menu or click the window�s close box. Tailor will ask
you if you want to save the changes you made.
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To save a document

Choose Save or Save As from the File menu. In the Save File dialog, you can se-
lect one of several file formats:

♦ Tailor�s �native� formats are PostScript and EPS (with low-resolution pre-
view).

♦ �Compatibility� formats include Adobe Acrobat PDF and Adobe Illustrator 3.
♦ Text formats include plain ASCII and formatted text (RTF).
♦ Pixel image formats include PICT, TIFF and GIF.

Depending on the output format you can choose to save all pages, a range of pages
or the current selection. Options for each of these formats can be set using the
Preferences Panel.

To print a document

Use the Page Setup command to select the physical media for the printer you are
going to use. (To change the page size or orientation of the Tailor document you
should use the Document Inspector, Page Size pane). Then use the Print com-
mand to print the document to a PostScript printer. Tailor will not print on a non-
PostScript printer!

Do not use the Print command to �Print to file�. This will create ill-behaved Post-
Script.

8.3. Converting PS and EPS files to other formats

Converting to PDF

Tailor can export a selection, a page or a complete document as an Adobe Acrobat
PDF file. The resulting file can be viewed and printed by Adobe�s Acrobat Reader
version 2.1 or later.

Tailor does not perform any sub-sampling on pixel images. In other words, pixel
images are included at full resolution, just like line work. LZW compression and
ASCII/Binary options can be set using the Preferences Panel. See User Guide,
Setting export preferences for PDF on page 55.

Converting to Illustrator 3

Tailor allows you to save a selection or a page in Adobe Illustrator 3 format. The
resulting file can be imported in Adobe Illustrator and in many other applications
for further editing.

Because of limitations in the Illustrator 3 format, the exported file may not be an
exact representation of the PostScript file. When this is the case, Tailor will pro-



Tailor 2.0 � User Guide

31

duce warning messages in the Document Inspector. See Reference Manual, Errors
and Warnings on page 118.

Extracting text

Tailor allows you to export a text column as formatted, flowing text that can be
imported into a word processor. Paragraphs are automatically recognized, and
most typographic attributes are preserved.

To save text without formatting, choose the Save As menu command, and select
the �Plain Text (ASCII)� format option in the Save File dialog. If you want format-
ting to be preserved, and you have a word processor that can read Rich Text For-
mat, select the �Formatted Text (RTF)� format option in the Save File dialog.

To place text on the clipboard, simply select the text column and choose Copy
from the Edit menu. The resulting text can be pasted in other applications such as
SimpleText. (Note that text copy is disabled in the demo version of Tailor).

To make the most of this text export capability, follow the following guidelines:

♦ Make sure that the text you want to export is displayed in the correct font or
at the very least use a font that has approximately the same character widths
as the original. The text export recognition algorithm depends heavily on the
font character widths.

♦ Text export does not recognize columns. For multi-column pages, select one
column at a time and set the �Selection only� option in the Save File dialog.

♦ Text export works on a single page at a time. For a multi-page document, ex-
port text for each page separately.

Rendering to pixel image formats

Tailor allows you to export a selection or a page in the following three pixel image
formats:

♦ PICT: a format mainly used by Mac OS applications.
♦ TIFF: Tagged Image File Format, a format commonly used on many plat-

forms.
♦ GIF: Graphic Interchange Format, a format commonly used on the Internet.

Tailor does not perform dithering or anti-aliasing when rendering to pixel image
formats. Where relevant, compression and RGB/CMYK color space options can be
set using the Preferences Panel. See User Guide, Setting export preferences for
PICT/TIFF/GIF on page 58.
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9. Editing a Document�s contents

9.1. Viewing a document

Zooming in and out

To zoom in by a factor of 2

Click the  button on the Window Toolbar or choose Zoom In from the View
menu.

To zoom out by a factor of 2

Click the  button on the Window Toolbar or choose Zoom Out from the View
menu.

To zoom in a rectangular area to the full window size

Click the  button on the Toolbox. Then drag a rectangle to define the area you
want to enlarge.

Note: the viewport tool stays active until you select another tool in the Toolbox.

To select a particular viewing scale

Click the  button on the Window Toolbar or choose Other... from the
View menu. Enter the viewing scale in the dialog box.

To bring a window on top if you opened multiple documents

Click on the window or choose the desired window from the Windows menu.

Wireframe mode

In the normal mode, called preview mode, you see the document as it will print.
In wireframe mode you only see the unfilled outlines of the objects.

Wireframe mode is useful for the following purposes:

♦ To view and select objects hidden behind other objects.
♦ To view and edit masks.
♦ To visually detect text that Tailor converted to paths (see User Guide, Setting

import preferences on page 49).
♦ To allow Tailor to redisplay the screen more quickly if the page contains many

or large pixel images.
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Note: True text objects (text not converted to outlines) always display �filled�,
even in wireframe mode.

To select wireframe mode

Click the  button on the Window Toolbar.

Selecting a page

To go to the next page

Click the  button on the Window Toolbar or choose Next Page from the View
menu.

To go to the previous page

Click the  button on the Window Toolbar or choose Previous Page from the
View menu.

To go to a particular page

Click the page number button on the Window Toolbar or choose Go to Page from
the View menu.

9.2. Selecting objects

Selecting a single object
♦ If the toolbox is not on the screen, choose Toolbox from the Windows menu.

♦ Choose the selection arrow  in the Toolbox.
♦ Click on the object. The selection handles appear.

To select an object that is hidden behind other objects

♦ Switch to wireframe mode by pressing the  button on the Window Toolbar
or by choosing Wireframe from the View menu.

♦ Click on the outline of the object. If necessary, zoom in to facilitate selection.

To select a mask

See User Guide, Working with groups on page 43.

Selecting more than one object

To select additional objects one by one

Press the Shift key while selecting. Selection handles appear for all selected ob-
jects.
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To select a set of objects

Drag a selection rectangle around the objects you want to select. All objects that
fall partially or completely inside the rectangle get selected.

If you press the Option key before you drag, only the objects completely inside the
selection rectangle are selected.

To select all objects

Choose Select All from the Edit menu.

Selecting consecutive objects

Objects in Tailor are arranged from the back to the front. The first object is the
�back-most� object and the last object is the �front-most� object.

To select the previous or next object

Choose Select Backward respectively Select Forward from the Edit menu.

To select the previous or next adjacent object

Choose Select Bw Local respectively Select Fw Local from the Edit menu.

This function allows you to select the previous or next object that is close to the
selected object (the bounding boxes overlap). This is very handy to select an object
that is difficult to select directly but located very close to an object you can select.

Deselecting

To deselect all objects

♦ Choose the selection tool in the Toolbar.
♦ In normal viewing mode: click on a point where there are no objects. Note that

this is not always possible. For instance, a large white background rectangle
may cover the complete page.

♦ In wireframe mode, click on a point a few millimeters away from any outline.

Or

Choose Deselect All from the Edit menu.

To deselect a single object

Press the Shift key while clicking to deselect a single object from a set of selected
objects.
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9.3. Moving, scaling, rotating and shearing visually

To move a selection

Click on an object in the selection and without releasing the mouse button drag
the selection.

Or

Use the arrow keys to nudge the selection pixel by pixel.

Press and hold the Option key to constrain the move to a horizontal or vertical
direction.

To scale a selection using the selection handles

Drag one of the selection handles.

If you use the corner handles, Tailor preserves the aspect ratio. If you use the
middle handles, the object is distorted.

To scale a selection from the center

♦ Choose the  tool from the Toolbox. If necessary bring up the toolbox by
choosing Toolbox from the Windows menu.

♦ Click on a point inside or outside the selection, and drag without releasing the
mouse pointer. The selection will scale in such a way that the mouse pointer
keeps the same position relative to the selection. Tip: start dragging at a suffi-
cient distance from the center of the selection. This will allow you to work
with greater precision.

♦ To constrain the scale factor to an integer number, press and hold the Option
key while dragging.

To rotate a selection around its center

Apply the same steps as for scaling, but choose the  tool instead of the Scale
tool.

Press the Option key to rotate in 15-degree steps.

To shear a selection around its center

Apply the same steps as for scaling, but choose the  tool instead of the Scale
tool.

Press the Option key to shear in 15-degree steps.
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9.4. Viewing and editing object attributes

Using the Graphic Inspector

The Graphic Inspector is a floating window that shows the attributes of the cur-
rent selection. It permanently stays open. This is very handy if you want to check
and/or modify attributes of multiple objects.

The Graphic Inspector has three panes. You can choose a pane from the selection
list at the top of the inspector. Each pane continuously reflects the attributes of
the selected object(s):

♦ The Attributes pane shows the graphical attributes.
♦ The Position pane shows the position, scale and rotation angle.
♦ The Statistics pane shows counts such as number of paths, number of charac-

ters, etc.

For a complete description of the Graphic Inspector, see Reference Manual,
Graphic Inspector on page 95.

All relevant fields in the Attributes and Position panes are editable. In that way
you can very easily modify attributes such as font, text size, color, line thickness,
position, etc. All changes are immediately reflected in the document.

To view attributes of an object

♦ If the Graphic Inspector is not on the screen, choose Graphic Inspector from
the Windows menu.

♦ Select the object you want to inspect.
♦ Select the proper pane in the Graphic Inspector.

To modify attributes of an object

Perform the steps listed above, then change the desired attribute(s). Note that
changes in a text field are reflected in the document only after pressing Enter or
clicking in another field of the Graphic Inspector.

Changing color

To change color you need the Color Mixer.

To bring up the color mixer

Choose Color Mixer from the Windows menu.

Or

Double click the color field in the Graphic Inspector, Attributes pane.
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To set up a color in the Color Mixer

♦ Select a color space by pressing one of the 5 color space buttons in the Color
Mixer.

♦ Use the sliders in the Color Mixer to obtain the desired color.

For more information about the Color Mixer or about the different color spaces,
see Reference Manual, Color Mixer on page 105.

To apply a color from the Color Mixer to the selected object(s)

Drag the color from the color field in the Color Mixer to the color field in the
Graphic Inspector.

Or

Double click the color field in the Color Mixer.

Notes:

♦ You can drag a color field�s color to any other color field.
♦ You can use the Color Mixer even if the Graphic Inspector is not on the

screen.

Changing a font

To change a font you need the Font Picker.

To bring up the Font Picker

Choose Font Picker from the Windows menu.

Or

Click on the Picker button on the Graphic Inspector, Attributes pane.

To change a font

Click on the desired font family and style in the Font Picker, and then press Ap-
ply.

Or

Double click on the desired font style in the Font Picker.

Note: you can use the Font Picker even if the Graphic Inspector is not on the
screen.

Understanding font substitution

A PostScript file may contain fonts that are not available on your system. In this
case Tailor uses a replacement font to display the text.
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If Tailor uses a replacement font, it displays two font names in the Graphic In-
spector:

♦ The name at the left is the name of the replacement font.
♦ The name at the right is the original font name as specified in the PostScript

file.

If you save the file, Tailor will by default use the original font name. However,
you can specify in the Preferences Panel, Export Fonts pane to use the replace-
ment font instead.

For more details on font substitution, see User Guide, Setting import preferences
on page 49 and User Guide, Understanding font handling on page 61.

9.5. Editing objects

Tailor allows you to edit text objects and paths. Paths are outlines that can be
filled or stroked. Pixel images cannot be edited directly in Tailor but you can edit
them using a third-party application.

To open an object for editing

Double click on the object.

Or

Choose Edit Text Lines respectively Edit Paths from the Edit menu. From the
submenu choose the Begin Edit ... command.

To edit text

Use the mouse or the left and right arrow keys to move the text cursor. You can
type text, select text using the mouse, delete text etc. in the usual manner.

To stop editing, click on an area outside the text line, or press the Enter key.

Note: PostScript does not support multi-line text or text lines with a non-uniform
style. Therefore, a text paragraph appears in Tailor as a set of individual text
lines. A text line containing font changes or other attribute changes appears as
several segments.

The Edit Text Lines submenu offers additional text editing features. See Refer-
ence Manual, Edit Text Lines Submenu on page 85.

To edit a path

Tailor provides functions to work on individual path nodes, and on the curved or
straight-line segments that connect them. This process of adjusting a path�s shape
is called node editing.
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To start editing a path: double click it with the mouse or select it and choose Edit
Paths - Begin Edit Nodes from the Edit menu.

For more information, see User Guide, Working with paths on page 41, and Ref-
erence Manual, Edit Paths Submenu on page 83.

To edit a pixel image

Export the image to an EPS file (see User Guide, Opening and saving documents);
import the EPS file in a pixel editing application; save the image as an EPS file
and import it back into Tailor. Copy and paste to the original position.

9.6. Working with character glyphs

Glyph names

A font definition, even for a Western language, typically contains more character
glyphs than can be accessed on any particular platform. Moreover, different plat-
forms (Mac OS, Windows, Unix, etc.) can each access a different subset of those
character glyphs. This subset is defined in a platform-specific character mapping
or �encoding vector�.

Since PostScript is cross-platform, it provides a mechanism to access any charac-
ter glyph in a font. This mechanism relies on glyph names to refer to a particular
character glyph. Glyph names are more or less standardized across different fonts
for the same language or writing script.

Internally, Tailor always uses a glyph name to refer to a particular character
glyph. In other words, a text line object contains a sequence of glyph names. For
most text, the translation between glyph names and the corresponding character
glyphs is completely transparent. However, in some cases, you may want to di-
rectly manipulate glyph names.

Adding glyphs by name

To insert one or more glyphs into a text line by name:

♦ Double click the text line to begin text editing.
♦ Click or use the arrow keys to position the text cursor.
♦ Choose the Add Glyphs command in the Edit Text Lines submenu of the Edit

menu or press the Escape key as a shortcut.
♦ In the modal dialog that pops up, scroll to view all glyph names in the current

font.
♦ Select a glyph name and click the Add button or double click the glyph name.
♦ Click the Done button to close the dialog window.
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The Glyphs dialog for Courier

Copying text between text lines

When you copy text from one text line object to another, Tailor actually copies
glyph names. As long as both objects have the same font, or as long as they have
fonts with a similar set of glyphs, there are no problems.

However, if the source and target fonts have a different set of glyphs, some glyph
names in the copied text may become undefined in the context of the new font. An
undefined glyph is displayed in Tailor as an outlined rectangle. When printed, an
undefined glyph is replaced by a space with a device-dependent width.

Changing the font of a text line

When you change a text line�s font, similar problems may occur. If the new and
old fonts have a different set of glyphs, some glyph names in the text line may
become undefined in the context of the new font. For example, switching a text
line�s font from Helvetica to Symbol makes most of its glyphs undefined.

Creating a text line in a symbolic font

To create a text line with a bullet in the Symbol font, follow this procedure:

♦ Click in the document window with the Text tool to create a new text line.
♦ Type an arbitrary character so that the text line is not empty.
♦ Press the Return key to terminate text-editing mode.
♦ Using the Font Picker, switch the text line�s font to Symbol.
♦ Click the text line to start text-editing mode once again.
♦ Delete the arbitrary character (which probably became undefined).
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♦ Press the Escape key to bring up the glyph name dialog.
♦ Select the �bullet� glyph name, and click the Add button.
♦ Click the Done button and press the Return key to terminate text-editing

mode.

Copying text to another application

When you copy text from Tailor to another application, Tailor automatically
translates glyph names to the corresponding character code in the Mac OS en-
coding vector. Glyphs that are not available in the Mac OS encoding are replaced
by a space.

9.7. Working with paths

Tailor provides functions to work on individual path nodes, and on the curved or
straight-line segments that connect them. This process of adjusting a path�s shape
is called node editing.

For example, you can:

♦ move nodes around
♦ control the shape of curved segments
♦ change a straight segment into a curved one, and vice versa
♦ cut paths into sub paths and vice versa

For an overview of the different menu items in the Edit Paths menu, see Refer-
ence Manual, Edit Paths Submenu on page 83.

To begin node editing

To begin node editing of a path, choose the normal  tool, and simply double
click anywhere on the path. In node editing mode, the path�s nodes are shown as
hollow rectangles the size of a selection handle.

To begin editing on the nodes of several paths at the same time, first select all the
relevant paths, and then double click one of the paths. With multiple path node
editing you can easily move common edges of coinciding or adjacent paths, such as
in bar charts.

As an alternative to double clicking, you can choose the Edit Paths - Begin Edit
Nodes command from the Edit menu. This starts node editing on the (set of) se-
lected path(s). The menu command may be useful to start editing an object that is
obscured by another object. Use Select Backward Local to select the targeted ob-
ject, and then choose Begin Edit Nodes to start editing, since double clicking
would reselect the front-most object.
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When working on a complex drawing with many overlapping paths, it may be
more practical to switch to wireframe mode. You can then "grab through" filled
paths, so that you can more easily locate the paths or nodes you want to modify.

To end node editing

♦ Click in the document window at some point well outside the bounding box of
the paths being edited (if possible at all).

♦ Choose any tool in the Toolbox.

Several commands, including copy and paste, are disabled while you are in node
editing mode. It is therefore good practice to end editing mode before you scroll to
another part of your document.

To select and move nodes

In node editing mode, you can select a node or a set of nodes in the usual manner:
click, shift click, or drag a rectangle. In most cases, it is wise to use rectangle se-
lect; this automatically includes all overlapping nodes in your selection.

To move all nodes in the current selection, simply drag one of the nodes in the
selected set. Press the Option key to constrain the move to horizontal or vertical
direction.

To manipulate Bezier control points

A path can have a mix of straight-line and curved segments. A straight-line seg-
ment is said to end in a line node; a curved segment is said to end in a curve node.
In other words, the type of a segment is determined by its end node.

The first node of a path is always a line node. That�s why a closed, curved path
such as a circle has overlapping start and end nodes.

The shape of a curved segment is determined by its Bezier control points. When
you select a single path node, or two adjacent path nodes on a segment, the corre-
sponding control points are shown. Drag one of the control points to modify the
curve�s shape.

                   

Moving the control handles of a curved segment changes the shape of the curve

Expert Note: Tailor�s Bezier editing differs in some ways from what you will find
in typical drawing applications. This is mainly because Tailor has to support un-
restricted PostScript paths, while a drawing application can impose arbitrary
(and sometimes rather subtle) limitations to help streamline the editing process.
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To modify nodes and segments

The Edit Paths submenu lists several commands to modify, add or delete nodes
and segments. See Reference Manual, Edit Paths Submenu on page 83.

Composite paths

A composite path consists of two or more disjoint sub paths. Composite paths can
be used to create �hollow� shapes, such as a doughnut. Composite paths can be
(node-) edited and otherwise manipulated in Tailor just as regular paths.

The Edit Paths menu contains the commands Split in Subpaths and Combine in
Subpaths to split or combine composite paths. Since these commands work on
path objects as a whole, you cannot invoke them from within node editing mode.

Note that filling a composite path is different from filling the subpaths separately.
Furthermore, if a composite is filled according to the non-zero winding number
rule, the result may depend on the direction of the subpaths.

9.8. Working with groups

What is a group

A group is a �container object� that contains a set of objects. By grouping the set
of objects, they behave as a single object. For instance, if you transform or
copy/paste the group, all objects in the group are affected. If you select any object
inside the group, the whole group is selected automatically.

Tailor automatically creates certain groups to facilitate editing of a document.
You can create groups yourself too.

Tailor allows you to edit objects inside a group without ungrouping (breaking the
group).

How Tailor uses groups

Many PostScript documents contain embedded EPS illustrations. During loading
of the document, Tailor automatically recognizes EPS illustrations and turns
them into groups. In that way you can easily manipulate the illustration as a
whole. What�s more, the Graphic Inspector, Attributes pane, shows useful infor-
mation about the EPS image, such as the title of the image and the name of the
program that was used to create it.

All objects associated with the same mask are placed in a group (a �group with
mask�).

Furthermore, Tailor places all the objects on each page of a document into a
group. For this �document group� the Graphic Inspector shows the title, creator
and creation date of the loaded PostScript document.
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Nested groups

A group can contain other groups. For instance, an EPS image contained in a
PostScript page is already a nested group: the �outer� group is the page, and this
group contains the EPS image that is also a group.

Navigating groups, editing an object inside a group

Tailor allows you to enter a group and to exit from a group. When you enter a
group, you can edit the objects inside the group. All objects outside the group are
grayed to indicate that they do not belong to the group. Grayed objects are pro-
tected against accidental selection or editing. To make grayed objects accessible
again, exit from the group.

The group level

The group level is a number indicating the current level in the group nesting hi-
erarchy. If you enter a group, the level increases by 1. If you exit the group, the
level decreases by 1.

In a freshly created, empty document (made by using the New command in the
File menu), the group level is 1. This is the lowest possible group level.

After loading a document the group level will typically be 2. All objects on the
page are contained in a group, and Tailor enters this group for you, resulting in a
group level of 2.

Group navigation buttons in the Window Toolbar

The Window Toolbar has three buttons for group navigation:

♦  : the enter group button

♦  : the group level indicator

♦  : the exit group button

To enter a group

♦ Select the group that you wish to enter.
♦ Press the Enter Group button on the Window Toolbar

or
Choose Enter Group from the Edit menu
or
Double click on the group.

The group level indicator increases by 1. Objects outside the group become
grayed.

To exit a group

Press the exit group button on the window toolbar.
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Or

Choose Exit Group from the Edit menu.

To select an object regardless of its grouping

You often want to select an object without caring whether it�s inside a group or
not. Tailor provides a very handy tool to do this: the group transparent selection

tool  in the Toolbox.

♦ If necessary bring up the Toolbox: choose Toolbox from the Windows menu.
♦ Choose the group-transparent selection tool from the Toolbox.
♦ Click on the desired object to select it.

If the selected object is inside a group (even inside a nested group) Tailor auto-
matically enters the group(s). The group level indicator reflects the grouping level
of the object.

To return to the main group (group level 2) press the exit group button in the
Window Toolbar until the group level indicator shows 2.

Creating a group, ungrouping

To create a group

♦ Select the objects you wish to group.
♦ Choose Group from the Arrange menu or press Command-G.

To ungroup (break a group apart)

♦ Select the group you wish to break apart.
♦ Choose Ungroup from the Arrange menu or press Command-U.

9.9. Editing and creating masks

A mask causes only the objects (or parts of objects) lying inside the mask to be
visible.

What is a group with mask

In Tailor, you can apply a mask to a set of objects by grouping these objects into a
group with mask. During loading of a document Tailor automatically creates
groups with a mask when necessary. However it does so in an intelligent way:
PostScript code often contains a lot of �useless� masks. These would seriously get
in the way when editing the document, because a lot of unnecessary groups would
be created. Tailor only creates groups with mask when necessary for correct ren-
dering.
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To view masks

♦ Go into wireframe mode: press the  button on the Window Toolbar or
choose Wireframe from the View menu.

♦ Masks are now visible as outlines drawn in a special color.

To edit a mask

♦ Go into wireframe mode (see above).
♦ Select the mask using normal selection or group-transparent selection.
♦ Use the normal path editing tools to edit the mask (including node editing).

To remove a mask

♦ Select the mask (see above).

♦ Press the  button so that the group holding the mask becomes selected.
♦ Uncheck the �Mask Enabled� checkbox in the Attributes pane of the Graphic

Inspector.

Note: You can not remove a mask using the Clear or Cut commands or the delete
key.

To create a mask

♦ Designate an existing object as mask, or create a new object. The object must
be a path. Select the object.

♦ If you use an existing object as mask, choose Bring to Front from the Arrange
menu.

♦ Select the object(s) you wish to mask; make sure you also select the mask. See
Selecting more than one object.

♦ Choose Group with Mask from the Arrange menu.

Note: You can use text as a mask by first converting it to a path: choose Edit Text
Lines, Convert to Outlines from the Edit menu.

9.10. Copying and pasting graphical objects

To copy a selection within Tailor

Use the Copy and Paste functions in the Edit menu to copy a selection to the same
document or to a different Tailor document.

To export text to a word processor

♦ If your word processor supports �styled text� (such as SimpleText), select the
text-column you wish to export and choose Copy from the Edit menu. You can
now paste the text in SimpleText, preserving formatting.
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♦ If your word processor supports �Rich Text Format� (such as Microsoft Word),
choose Save As from the File menu. Select whether you want to export the
current selection or the current page. In the Format selection list, choose
Formatted Text (RTF). You can now import this RTF-document into your
word processor, preserving formatting.

♦ If none of the above applies, you can export plain, unformatted text. Para-
graph breaks are still preserved. This format can be imported into any word
processor or text editor. To export plain text, use copy and paste (as described
above for Styled Text) or choose Save As from the File menu. Select whether
you want to export the current selection or the current page. In the Format
selection list, choose Plain Text (ASCII).

To import a PICT into Tailor

If you have an application capable of copying an image to the clipboard in PICT
format, use the application�s Copy command to do so. Screen grabbers typically
support keyboard shortcuts to copy the grabbed selection to the clipboard. If you
have a PICT file on disk, you can open it in SimpleText and copy its contents to
the clipboard.

Switch to Tailor and select the document into which you want to insert the PICT.
Choose Paste from the Edit menu to insert the PICT into your document as a
regular pixel image. You can move, scale or otherwise transform the pixel image
as usual. However, the image itself is not editable within Tailor.

To export a selection to a different application

To export a selection of graphical objects, produce an EPS file using Save As from
the File menu. In the Format selection list, make one of the following choices:

♦ If you want the objects to be rendered exactly (on PostScript printers) choose
Encapsulated PostScript

♦ If you are exporting to Adobe Illustrator, choose Adobe Illustrator 3. This will
allow you to edit the objects in Illustrator. Note that some graphic attributes
are not supported by the Adobe Illustrator 3 format. Therefore some objects
may not render correctly. For example, Adobe Illustrator 3 only supports eo-
fill, not fill (non-zero-winding fill).

When the EPS file is ready, import it into the other application.

To import data from a different application

To import from another application, you can use the following procedure:

♦ From the application, produce a PostScript or EPS file. Almost any applica-
tion can �print� to a PostScript file. Some applications can export to EPS.
Note: if you want to use an Adobe Illustrator file, make sure you saved it with
EPFS header.

♦ Open the document in Tailor. It will appear in a new window.
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♦ Use Tailor Copy/Paste to paste the desired object(s) into your document.
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10. Setting Preferences

You can customize Tailor to your own preferences using the Preferences Panel.

To change a preference

♦ Choose Preferences Panel from the Windows menu.
♦ Select a category using the selection list at the top.
♦ Change the desired item(s).

Changes take effect immediately. Tailor automatically saves your preferences.

For details on each preference, See Reference Manual, Preferences Panel on page
109. The material in the Reference Manual is organized per pane in the panel.
Sometimes, this makes it hard to figure out which preferences apply to a certain
situation.

The sections below list the preferences that are relevant for importing from or
exporting to a particular format.

Note: the screen grabs show the factory default preference settings.

10.1. Setting import preferences

Tailor can open PostScript and Encapsulated PostScript (EPS) files. The import
preferences apply to both formats.

Font usage and ordering

When importing text set in a particular font, Tailor can look for the corresponding
font information in several ways:

♦ System fonts: the fonts installed on your computer.
♦ Embedded fonts from this file: any fonts embedded in the file currently being

imported.
♦ Embedded fonts from other files: any fonts embedded in (and extracted from)

a file previously imported in Tailor during the current session. The embedded
fonts database is cleared each time you launch Tailor.
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♦ Outlines: use fonts embedded in the file currently being imported to convert
the text to outlines.

By turning the appropriate checkboxes on or off, you can specify which of these
font information sources Tailor should use.

Tailor searches the font information sources in the order listed. For example, with
the settings shown in the example, if the font Helvetica is both embedded in the
file being imported and installed on the system, Tailor will use the system font
and ignore the embedded font.

By clicking the arrow button, you can modify the order in which system and em-
bedded fonts are searched. Thus you can use the font embedded in a file, even if a
font with the same name is installed on your computer.

For more in-depth information on font handling, see User Guide, Understanding
font handling on page 61.

Default substitution font

If none of the �allowed� font information sources described above can satisfy the
search for a particular font, Tailor substitutes the originally specified font by an-
other font.

To set the default substitution font, click the Set� button and select one of the
fonts listed in the dialog box that appears.

In addition, the Font Picker allows you to set a specific substitution font for a par-
ticular unavailable font. These �substitution� relationships are preserved between
Tailor sessions. For more information on the Font Picker, see Reference Manual,
Font Picker on page 106.

For more in-depth information on font handling in general, see User Guide, Un-
derstanding font handling on page 61.

Reconstruct page breaks

Turn on the �Reconstruct Page Breaks� check box to make Tailor insert page
breaks at the locations indicated by the structured comments in the imported file.
This may be necessary for PostScript files that do not properly execute the �show-
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page� PostScript operator at the end of each page. On the other hand, with some
PostScript files it may cause unwanted extra page breaks.

Generally, you should leave this option turned off.

Reconstruct spot colors

Turn on the �Reconstruct Spot Colors� check box to make Tailor convert process
colors to spot colors, where appropriate. This may be necessary for PostScript files
that do not use the proper operators for setting spot color. On the other hand,
with some PostScript files it may cause some process colors to be converted to spot
colors inadvertently.

Generally, you should leave this option turned off.

Emulated Resolution

PostScript is designed to be device independent. Therefore a page description
should never assume a particular device resolution. Unfortunately, some drivers
generate questionable PostScript that does rely on device resolution. In such cases
it may be necessary to set the emulated resolution field to the resolution of the
target device. Tailor will then behave like a device that has this resolution.

10.2. Setting export preferences for PS

Original or Substituted font name

Specifies the font attribute that Tailor uses in the output file when saving a text
object in a substituted font.

♦ Export original font name: Tailor uses the original font name specified in the
input file.

♦ Export substituted font name: Tailor uses the name of the substitution font.

See User Guide, Understanding font handling on page 61.
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Include fonts

Specifies which fonts should be included (embedded) in the output file.

♦ None: no fonts are included in the saved document.
♦ Embedded only: only fonts marked as �embedded� in the Font Picker are in-

cluded in the saved document.
♦ All but standard 13: if a font is one of the standard 13 fonts most PostScript

printers have built in, it is not included. Otherwise it is included.
♦ All: all fonts are included.

Mask around page

When this checkbox is turned on, Tailor places a mask around each exported
PostScript page, exactly at the page borders. The latter ensures that nothing is
being painted outside the page borders. On the other hand, the mask cuts off any
�bleeds� that may have been placed outside the page borders on purpose.

See User Guide, Understanding page size on page 71.

Image format & compression

Pixel images embedded in a PostScript file can be written in one of the four fol-
lowing formats:

♦ Uncompressed Hexadecimal text
♦ Uncompressed Binary data
♦ LZW compressed ASCII85 text
♦ LZW compressed Binary data
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The LZW compressed formats result in (considerably) smaller files, but they can
only be printed on PostScript level 2 printers.

The binary formats result in smaller files as well, but they can not be transported
over 7-bit ASCII communication channels, and may not be fully portable across
different computer platforms.

Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Though PostScript printers accept
all three conventions, files may be more easily transportable to other platforms by
selecting the appropriate line separator convention.

10.3. Setting export preferences for EPS

The EPS format shares all PostScript export preferences:

♦ Original or Substituted font name.
♦ Include fonts.
♦ Image format & compression.
♦ Mask around page.
♦ Line Separator.

With the exception of �Mask around page�, these preferences have identical
meaning for both formats, so they are not described again. Please refer to the pre-
vious section.

The �Mask around page� has a slightly different meaning for EPS, so it is de-
scribed below with the EPS specific preferences.

Bounding Box

Page layout applications use the bounding box of an EPS image to calculate the
size of the image and to correctly position the image on a page.
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Generally, the bounding box corresponds exactly to the intrinsic image size. How-
ever, in some circumstances, it may be useful to add extra space to one or more
sides of the image.

When this preference is set to �Use image size�, Tailor calculates the intrinsic size
for the exported image, and uses that size as the EPS bounding box. When it is set
to �Use page borders�, Tailor uses the page borders provided by the user instead.

The �page� borders for an EPS document are shown and manipulated in the same
way as the page borders for a PS document. You can modify the page borders us-
ing the Document Inspector, or directly drag them around in wireframe viewing
mode.

See User Guide, Understanding page size on page 71.

Mask around page

When this checkbox is turned on, Tailor places a mask around the bounding box
specified for the EPS image. This ensures that nothing is being painted outside
that bounding box.

Note that the EPS bounding box, and thus the mask position, depend on the pre-
viously described �Bounding Box� preference setting.

See User Guide, Understanding page size on page 71.

Preview image

An EPS file typically includes a low-resolution preview image. Page layout appli-
cations use this preview to display the image on the screen, since they lack the
PostScript interpreter necessary to display the EPS image itself. The low-
resolution preview is discarded for printing.

Tailor provides three options:

♦ No preview: this somewhat reduces EPS file size, however it is not recom-
mended.

♦ Include PICT preview: this is the preview format used on Mac OS; it is not
compatible with other platforms.

♦ Include TIFF preview: this is a preview format supported by most applica-
tions on most platforms, including Mac OS and Windows.
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Include showpage, center on page

Include showpage operator: specifies to include a showpage command in the EPS
file. This is required by the EPS standard but some programs malfunction if it is
present.

Center image on page: specifies to position the saved EPS image in the center of
the current �default� page, rather than in the lower left corner. The default page
size can be specified in the Preferences Panel, Document pane. Centering an EPS
image is useful when you want to print the EPS file on its own, using a PostScript
downloader.

With most page layout applications, centering an EPS image does not affect the
program�s ability to correctly place the image.

10.4. Setting export preferences for PDF

Original or Substituted font name

Specifies the font attribute that Tailor uses in the output file when saving a text
object in a substituted font.

♦ Export original font name: Tailor uses the original font name specified in the
input file.

♦ Export substituted font name: Tailor uses the name of the substitution font.

See User Guide, Understanding font handling on page 61.

Include fonts

Specifies which fonts should be included (embedded) in the output file.

♦ None: no fonts are included in the saved document.



Tailor 2.0 � User Guide

56

♦ Embedded only: only fonts marked as �embedded� in the Font Picker are in-
cluded in the saved document.

♦ All but standard 13: All fonts are included, except for those in the set of 14
fonts that are always available to the Acrobat viewer.

♦ All: All fonts are included, except for those in the set of 14 fonts that are al-
ways available to the Acrobat viewer.

Note that, in the case of PDF export, the options �All but standard 13� and �All�
behave identically, because the standard font set is guaranteed to be available to
all PDF viewers.

Furthermore, PDF viewers have a standard set of 14 fonts, rather than 13 as sug-
gested by the name of the option �All but standard 13�.

Compression

Turn the checkboxes on or off to select compression for PDF page descriptions
(�Text and Line Art�) and/or out-of-line pixel images (�Images�).

Format

Select Binary to generate more compact PDF files. Select ASCII to optimize
transportability over 7-bit communication channels and across platforms.

Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Though Adobe Acrobat Viewers
accept all three conventions, files may be more easily transportable to other plat-
forms by selecting the appropriate line separator convention.
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10.5. Setting export preferences for AI3

Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Though most applications accept
all three conventions, files may be more easily transportable to other platforms by
selecting the appropriate line separator convention.

10.6. Setting export preferences for ASCII

Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Files may be more easily trans-
portable to other platforms by selecting the appropriate line separator convention.

10.7. Setting export preferences for RTF

Original or Substituted font name

Specifies the font attribute that Tailor uses in the output file when saving a text
object in a substituted font.

♦ Export original font name: Tailor uses the original font name specified in the
input file.

♦ Export substituted font name: Tailor uses the name of the substitution font.

See User Guide, Understanding font handling on page 61.
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Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Files may be more easily trans-
portable to other platforms by selecting the appropriate line separator convention.

10.8. Setting export preferences for PICT

The text field specifies the resolution of the exported PICT image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

10.9. Setting export preferences for GIF

The text field specifies the resolution of the exported GIF 89a image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

Turn on the check box to produce an interlaced GIF file. Most web browsers sup-
port �gradual updating� when downloading an interlaced GIF file.

GIF 89a files are always LZW compressed.

10.10. Setting export preferences for TIFF

Use the radio buttons to select RGB or CMYK color space for the exported TIFF
file. Tailor converts colors to the target space using a very simple (and not very
accurate) algorithm. Older TIFF readers may not support the CMYK color space.
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The text field specifies the resolution of the exported TIFF image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

Turn on the check box to use LZW data compression, resulting in a smaller file.
Older TIFF readers may not support LZW compression.

10.11. Setting export preferences for PhotoShop

There are two distinct mechanisms to transport an image from Tailor to Adobe
PhotoShop:

♦ Extracting a single pixel image embedded in a PostScript file.
♦ Rendering an arbitrary selection of objects, creating a new pixel image.

Extracting a pixel image

To transport a single pixel image embedded in a PostScript file to PhotoShop, se-
lect the image and save the selection as EPS, using the preference settings de-
scribed below. Subsequently, import the resulting EPS file in PhotoShop.

With this mechanism, the transported pixel image retains its original resolution
and color space, so there is no quality loss. However, it only works for a single
pixel image at a time.

Note: this mechanism works only for pixel images with a number of bits per sam-
ple of 1 or 8. There may be 1, 3 or 4 samples (grayscale, RGB, or CMYK).

Setting the PS and EPS export preferences for compatibility with PhotoShop

For more information on these preferences, see User Guide, Setting export prefer-
ences for PS on page 51 and User Guide, Setting preferences for EPS on page 53.

Set this option to �Uncompressed Hexadecimal text�. The other formats are not
compatible with PhotoShop.

Set this option to �Use image size�. Using the page borders would confuse Photo-
Shop about the size of the image.
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Rendering an arbitrary illustration

To transport an arbitrary selection out of a PostScript page to PhotoShop, save
the selection from Tailor as TIFF, and import the resulting file in PhotoShop.

With this mechanism, Tailor renders the image using the resolution and color
space you specify. This means you can transport any combination of objects, in-
cluding paths, text and pixel images. However, you are limited to Tailor�s ren-
dering and color conversion algorithms.

Setting the TIFF export preferences for compatibility with PhotoShop

For more information on these preferences, see User Guide, Setting preferences
for TIFF on page 58.

♦ Color Space: select RGB or CMYK according to your needs.
♦ Resolution: enter a value according to your needs.
♦ LZW compression: it is best to turn this option on.
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11. Advanced Issues

11.1. Understanding font handling

System fonts

The �system fonts� are all scalable fonts (Adobe Type 1 or TrueType) installed on
the computer running Tailor. Tailor ignores any non-scalable bitmap fonts.

As usual, Tailor can only display Adobe Type 1 fonts correctly if Adobe Type Man-
ager is installed and enabled on your computer.

Text that has been imported using a system font is represented as text line ob-
jects, with the appropriate font attribute. The system font information is used to
display and export the text. Because of its speed, accuracy and ease of use, this
situation is surely the most desirable one. Therefore, it is highly recommended to
install all fonts that regularly occur in documents you process with Tailor.

Embedded fonts

Many PostScript files contain embedded font information. As part of the Post-
Script document structuring conventions (DSC 3.0), Adobe has defined specific
rules on how embedded font information should be structured.

Conforming and non-conforming fonts

Embedded Adobe Type 1 fonts almost always conform to the structuring conven-
tions, regardless of the platform on which the PostScript file was generated. This
means that Tailor can recognize and extract these fonts for further use.

For embedded TrueType fonts, the situation is more complex. In some cases, these
fonts conform to the structuring conventions and provide a �Type 1 equivalent� for
use by PostScript interpreters that do not support TrueType fonts. Most modern
PostScript drivers on Mac OS output TrueType fonts that belong to this category.
Tailor can recognize and extract these conforming TrueType fonts just like em-
bedded Type 1 fonts.

However, in many cases, embedded TrueType fonts do not conform to the struc-
turing conventions at all. Unfortunately, nearly all PostScript files generated on
the Windows platform belong to this category. Tailor cannot recognize and extract
non-conforming fonts. Instead, Tailor will substitute another font, or convert all
text set in such fonts to outlines.
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Extracting embedded fonts

If you turn on the appropriate import preference, and you import a file with con-
forming embedded fonts, the embedded fonts are added to the Font Picker. From
that point on, and until you quit Tailor, you can use the embedded fonts just like
regular available fonts.

The Font Picker, with an embedded font selected

As you can see in the illustration, Tailor remembers the name of the file from
which a particular embedded font was extracted. This makes it possible to have
multiple fonts with the same name, each one extracted from a different file, or to
have both a system font and an embedded font with the same name.

Displaying embedded fonts

To display text in an embedded font, Tailor needs to retrieve the font�s informa-
tion using its own mechanism, rather than the system functions used for regular
available fonts. Consequently, the resulting text is somewhat less readable, dis-
plays more slowly, and consumes more memory.

However, text that has been imported using an embedded font is still represented
as text line objects, and all text attributes and full text editing capabilities are
preserved.

Converting text to outlines

If font information is embedded in the file, but does not conform to the structuring
conventions, you still have the option to convert text in that font to outlines.

In that case, Tailor uses the embedded font information by converting each char-
acter of the text to its outline form as specified in the font definition. In other
words, each character is converted to a filled path with the form of the character.
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The text to outline conversion process consumes a fair amount of resources (both
processing time and memory). The result however, visually matches the originally
requested typeface. On the other hand, it is no longer editable as text.

Unavailable or Substituted fonts

If no font information is embedded in the file being imported, or if you turned off
all relevant font-importing preferences, Tailor substitutes another font for the
unavailable font.

You can change the default font Tailor uses for substitution using the Preferences
Panel. See User Guide, Setting import preferences on page 49.

In addition, the Font Picker allows you to set a specific substitution font for a par-
ticular unavailable font. These �substitution� relationships are preserved between
Tailor sessions. For more information on the Font Picker, see Reference Manual,
Font Picker on page 106.

Since the widths of the substituted characters are likely to differ from those of the
original characters, the imported text may not look very well. But at least all the
text is there and, if the substitution font is well chosen, it will be readable and
editable. In many cases, you can export the text using the originally requested
font names (see below).

Preferences for font usage and ordering

As described in the previous sections, Tailor can look for font information in sev-
eral places, and handle that information in several ways. By setting the appropri-
ate import preferences, you can specify which font sources Tailor should use, and
in which order.

For more details, see User Guide, Setting import preferences on page 49.

Adding and removing system fonts

Several third party applications can add and remove system fonts �on the fly�, i.e.
while other applications are running. Tailor detects changes to the list of system
fonts and updates its internal data structures accordingly, including the Font
Picker.

When you remove a font that is used in an open Tailor document, the corre-
sponding substitution font replaces it, and all text in the font is redrawn.

When you add a font that was needed but unavailable in an open Tailor docu-
ment, the font becomes available and all text in the font is redrawn. However, the
text�s positioning and tracking was determined while importing the document,
using the substituted font�s incorrect widths. To remedy this situation, re-open
the document after you made the font(s) available.
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Adobe Type 3 fonts

The fonts we have discussed so far are Adobe Type 1 or TrueType fonts. Adobe
Type 3 fonts are a special kind of PostScript fonts, typically used by applications
to represent fancy symbols such as widget bullets or scatter graph points.

Adobe Type 3 font definitions are always embedded in the PostScript file. Tailor
automatically converts all characters set in an Adobe Type 3 font to outlines. The
result visually matches the original character, but is no longer editable as text.

Some older applications or PostScript drivers use Adobe Type 3 fonts to define
bitmap fonts in a PostScript file. Rather than providing a scalable outline, bitmap
character definitions provide a raster representation optimized for a certain out-
put resolution. Tailor converts such bitmap characters to pixel images.

Forced conversion to outlines

It has been noted above that many embedded TrueType fonts do not conform to
the PostScript document structuring conventions. Sometimes, the font informa-
tion is represented in such a way that Tailor cannot preserve text-editing capa-
bility for the font. Whenever this happens, Tailor automatically converts any text
in the font to outlines, regardless of the import preference settings.

Unfortunately, the TrueType fonts in many PostScript files generated on the
Windows platform belong to this category. On the other hand, Adobe Type 1 fonts
are usually not affected.

Text Line Groups

As described above, text lines may (under certain circumstances) be converted to
paths or pixel images during the import process.

The representation (outline paths or pixel images) for all characters in a certain
text line are assembled in a �text line group�. Note that a text line group is also
created when you use the Convert to Outlines menu command to convert a text
line to paths.

On the one hand, a text line group behaves like a regular group. You can enter it
and manipulate or edit its members just as with any other group. On the other
hand, a text line group remembers information about the represented text�s at-
tributes. This information is displayed in the Graphic Inspector when the text line
group is selected. It can not be modified.

You can use the Edit Text Lines - Revert to Text menu command to convert an
outline group to a regular text line. If the specified font is not available, the corre-
sponding substitution font is used instead.

Note 1: Many Adobe Type 3 fonts and non-conforming TrueType fonts do not
carry enough information to perform meaningful text substitution. Performing
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Revert to Text on a text line group derived from such font results in a blank or
"scrambled" text line. Use Undo to get back to the text line group.

Note 2: Text imported as outlines looks fatter than normal text. This is because
the PostScript rendering algorithm paints more pixels when filling regular out-
lines than when rendering characters in a font defined with the same outlines.
This is quite noticeable for low resolution output, such as on a screen. For higher
resolutions the effect becomes much less prominent.

Exporting text in a substituted font

As described above, text lines may (under certain circumstances) be imported
with a substituted font. For a text line in a substituted font, the Graphic Inspec-
tor, Attributes pane, shows two font names, like this: �Times-Roman << Optima-
BoldOblique�. This means that Times-Roman was used instead of Optima-
BoldOblique.

A substituted font in the Graphic Inspector

When exporting such a text line, Tailor can use the substituted font name (Times-
Roman in the example), or it can use the originally requested font name (Optima-
BoldOblique). You can specify your choice in the Preferences Panel. See User
Guide, Setting export preferences for PS on page 51.

In many cases, exporting the originally requested font name creates the possibil-
ity to edit and save a document without having the appropriate fonts available.

However, some publishing applications depend on the correct font being present
in the target printer (in this case, Tailor) to calculate precise kerning (inter-
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character spacing). For documents generated by those applications, proper kern-
ing is ruined by font substitution, even when you export the originally requested
font name.

Including fonts in a saved document

You can specify in the Preferences Panel which fonts should be included in a file
saved from Tailor. See User Guide, Setting export preferences for PS on page 51.

Tailor can output both system fonts and embedded fonts. An embedded font is
output exactly as it was found in the file from which it was extracted.

A system font is output so that it fully conforms to the PostScript document struc-
turing convention. For a TrueType font, the output contains a (more or less)
equivalent Type 1 description, so that the font can be rendered on all PostScript
printers.

11.2. Working with spot colors

What is a spot color

A spot color is a color that is printed in a separate pass, using a single ink. In con-
trast, a process color is printed using a mix of Cyan, Magenta, Yellow and Black
(CMYK).

To view the list of spot colors used in the document
♦ If necessary, open the document inspector: choose Document Inspector from

the Windows menu.
♦ Select the Spot Colors pane from the selection list at the top.

Document Inspector showing the Spot Color pane

To change the color of an object to spot color
♦ Select the object.
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♦ Drag the desired spot color from the Document Inspector to the color field on
the Graphic Inspector, Attributes pane.
Or
Drag the spot color to the Color Mixer (spot color space = rightmost button)
and from there to the Graphic Inspector. Using the Color Mixer allows you to
specify a tint of the color, for instance 50%.

Color Mixer: editing a Spot Color

To change a spot color

In the Spot Color pane of the Document Inspector, you can change the name and
the appearance of a spot color.

♦ The name is an editable text field. You can edit it in the usual way. Note that
spot colors should have unique names.

♦ To change the appearance of the color, create a color using the Color Mixer
(any color space) and drag the color from the Color Mixer to the desired color
field in the Document Inspector.

Important: If you change the appearance of a spot color, all objects painted in that
color will reflect that change.

To create a new spot color

In the Spot Color pane of the Document Inspector, scroll to the end of the spot
color list and press the downward arrow. Then follow the procedure to change a
spot color.

11.3. Working with OPI images

OPI (shorthand for Open Pre-press Interface) is a mechanism for referring to an
external image file from within a PostScript document, using structured com-
ments. A low-resolution preview image may be included in addition to the refer-
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ence to the external file. Just before printing, the OPI server software replaces
the OPI reference by the original, high-resolution image. This way, large images
can remain at a central server, rather than being passed along with the Post-
Script file throughout the production workflow.

In a strict sense, OPI is a specification maintained by Adobe. However, the term is
commonly used to indicate any mechanism of linking to external files from within
PostScript.

Importing and exporting

Tailor recognizes and preserves OPI comments conforming to the major standards
(OPI 1.3, OPI 2.0, Luminous Color Central, and Helios EtherShare). If necessary,
the exported comments are updated to reflect any edits performed by the user.

Viewing and editing

An OPI image is incorporated in Tailor�s display list as a special group object
called an �OPI group�. An OPI group is similar to a regular group because it can
contain other objects. More specifically, if a low-resolution preview for the OPI
image is available within the PostScript file, the OPI group contains the preview
image. If there is no preview, the OPI group substitutes a gray rectangle.

As opposed to a regular group, you cannot enter an OPI group for further editing
(since you cannot modify the preview image). However, an OPI group can be
resized, rotated and moved as usual.

When you select an OPI group, the Graphic Inspector, Attributes pane shows the
file path for the original OPI image and the crop rectangle applied to the image.
You can modify both items. Furthermore, you can remove the preview image. See
Reference Manual, Graphic Inspector on page 95.

11.4. Using Tailor Converter

Tailor Converter is an AppleScript application that uses Tailor to convert between
various file formats and that can save you a lot of valuable time. If you regularly
have to convert PostScript or EPS files into other formats Tailor Converter can do
the job for you.

Getting Started

Make sure that AppleScript is installed on your computer. AppleScript is part of
Mac OS 7.5, so it should be readily available, if not already installed.

The Tailor Converter files are distributed in the archive that contains Tailor�s
documentation. Note that Tailor Converter can not operate without Tailor. It is
an AppleScript application that will launch Tailor to do the actual conversion.
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To set up Tailor Converter�s options, double click its icon in the Finder. You will
be guided through a number of dialog boxes to choose various conversion options.
After that, each time you drag one or more files or folders over Tailor Converter�s
icon, they will be converted using the options you chose.

Conversion Options

Conversion Format

Tailor Converter can read PostScript and Encapsulated PostScript files. It can
convert these files to the following formats:

♦ �Native� formats: PostScript and EPS.
♦ �Meta� formats: Adobe Illustrator and PDF.
♦ �Raster� formats: PICT, GIF and TIFF.

Split PostScript files

When you choose to convert files to PostScript format you have two options: save
the whole document in one file or save each page of the original file into a differ-
ent file.

First page only

When you have selected a single-page output format, you can choose to save only
the first page of the original document or to save each page of the original docu-
ment into a separate file.

Converted file destination

This option determines where you want Tailor Converter to store the converted
files. See below for more details.

Hot folder support

You can optionally specify a folder that Tailor Converter checks from time to time
for new files to be converted.

Converted file destinations

Next to input

This option will store each converted file in the same folder as the input file. The
original file will not be overwritten. Instead, the converted file is given a different
name: if you translate the PostScript file test.ps into PostScript format, the output
file will be given the name test_out.ps.

In fact this example is not as useless as it might seem. Translating a PostScript
file to PostScript has the beneficial effect that Tailor will convert questionable
PostScript into well-behaved PostScript.
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When you choose the �next to input� option, Tailor Converter works in so-called
interactive mode. In this mode the Converter shows you a dialog box whenever
Tailor reports any difficulty during importing or exporting a file.

In a special folder

You can tell Tailor Converter that you have a special folder where all converted
files should be stored. If you choose this option, all output files of Tailor Converter
will be stored in that folder. When you decide to place your files in a dedicated
folder, Tailor Converter works in automatic mode. In this mode no error messages
or dialog boxes are shown while Tailor is converting. Instead, all actions are
logged to a log file named TailorConverter.log.

The log file is a plain text file that you can view with SimpleText or any other text
viewer. It contains different sections. A first section describes the settings used to
convert the files. The second section gives a detailed report with import and ex-
port messages for each file. The final section features statistics containing a
summary of the number of files converted and the total number of conversion
messages.

Converting files

When you have set the options you want to use, converting your files is as simple
as selecting them in the Finder and dragging them on Tailor Converter�s icon. The
rest is fully automatic.

Whenever you want to check or change the options of Tailor Converter, just dou-
ble click its icon and change options to your needs.

Extending Tailor Converter

If you know how to program AppleScript, you can extend or modify Tailor Con-
verter�s capabilities according to your needs.

The AppleScript source code for Tailor Converter and related instructions are in-
cluded in the distribution kit. The file with instructions is called �Tailor Converter
ReadMe�.

11.5. Placing Tailor in an OPEN pipeline

Tailor can be used in conjunction with Luminous OPEN, a workflow management
solution, to automatically clean up and streamline PostScript files in batch.

Files processed through Tailor fully conform to the Document Structuring Con-
ventions (DSC 3.0), and they contain very �clean� PostScript. This ensures that
the files will render correctly, without late-stage PostScript errors. Additional
benefits include faster processing by and increased compatibility with trapping
and impositioning solutions further down the OPEN pipeline.
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Getting Started

The files needed to make Tailor �OPEN-aware� are distributed in the archive that
contains Tailor�s documentation:

♦ Tailor.OPN: a configuration file to be installed in an OPEN related folder.
♦ Rewrite PS: a compiled AppleScript file to be installed in an OPEN related

folder.

To install Tailor as an OPEN-aware application do the following:

♦ Start the OPEN application and target the Tailor application on your hard
disk.

♦ Locate and open the folder where you installed the OPEN application on your
hard disk.

♦ Copy the �Rewrite PS� file into the �Tailor� subfolder of the �OPEN Applica-
tion Scripts� folder.

♦ Copy the "Tailor.OPN" file into the "OPEN Configuration Files" folder.

The Tailor icon should now be available as pipeline item in OPEN.

Customizing

If you know how to program AppleScript, you can extend or modify the �Rewrite
PS� script that controls Tailor�s behavior from OPEN.

The AppleScript source code for �Rewrite PS� is included in the distribution kit.
The source file is called �Rewrite PS.script�.

11.6. Understanding page size

PostScript files

PostScript files can hold page size and orientation information in two different
places: in the structured comments and in the PostScript code proper. In addition,
the structured comments normally specify the bounding box of the visible image
on the page(s).

Importing

Tailor can use both sources of page size and orientation information. If both
sources are available, the information in the PostScript code proper takes prece-
dence. If no information is available at all, Tailor applies the default size and ori-
entation specified in the Preferences Panel, Document pane.

In some cases, the information about a PostScript document with landscape orien-
tation is ambiguous or missing. In those cases, Tailor may display the document
oriented incorrectly or even upside down. You can correct such a situation with
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one click, using one of the �Rotate Now� buttons on the Document Inspector, Page
Size pane.

Exporting

Tailor always generates conforming structured comments for page size, page ori-
entation and visible image bounding box. Furthermore, Tailor includes a Post-
Script operator to set the correct page size. Only devices that support PostScript
level 2 recognize this operator; level 1 devices ignore it.

EPS files

Since an EPS file represents an illustration, not an assembled page, the concept of
page size does not really apply. Instead, an EPS file has a bounding box, which
matches the visible area of the image in most cases.

Importing

Tailor recognizes the bounding box information specified in the structured com-
ments of an EPS file, and uses it as �page size� while viewing and editing the
EPS. If no bounding box information is available, Tailor uses the default page size
and orientation specified in the Preferences Panel, Document pane.

Exporting

Page layout applications use the bounding box of an EPS image to calculate the
size of the image and to correctly position the image on a page.

As stated above, in most cases the bounding box corresponds exactly to the intrin-
sic image size. However, in some circumstances, it may be useful to add extra
space to one or more sides of the image.

Tailor provides a user preference exactly for this purpose. When this preference is
set to �Use image size�, Tailor calculates the intrinsic size for the exported image,
and uses that size as the EPS bounding box. However, when the preference is set
to �Use page borders�, Tailor uses the page borders provided by the user (see
Modifying page size below).

For more information on this and related preferences, see User Guide, Setting
export preferences for EPS on page 53.

Modifying page size

You can inspect and modify a document�s page size and orientation using the
Document Inspector, Page Size pane. Alternatively, you can directly drag the
page borders to a new position when you are in wireframe viewing mode.

Note that the �page� borders for an EPS document are shown and can be ma-
nipulated in the same way as the page borders for a PS document.
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You can not use the Page Setup command in the File menu to modify a docu-
ment�s page size or orientation. Instead, use the Document Setup command to
bring up the Document Inspector. For more information on the Page Setup com-
mand, see User Guide, Understanding printing below.

11.7. Understanding printing

Printing from Tailor is limited to PostScript printers only. Remember that Tailor
is a PostScript editor.

Page size and orientation

Document

To change a document�s page size or orientation, use Tailor�s Document Inspector,
Page Size pane. You can use the Document Setup command in the File menu to
bring up the Document Inspector.

Physical page

The page size and orientation specified using the Page Setup command in the File
menu do not affect the Tailor document; they only specify the physical media to be
used by the printer.

You should always set the orientation of the physical page (using Page Setup) to
�portrait�, regardless of the logical orientation of the document.

The other options on the Page Setup panel (N-up, scaling, etc.) and those on the
Print panel (paper source, printer settings, etc.) should work as expected.

Fonts

When printing a document, Tailor lets the printer driver decide which of the
available system fonts are sent to the printer. If a document uses an embedded
font (marked as such in the Font Picker) Tailor always sends this font to the
printer.

Print to file

Do not use Tailor�s Print command to save PostScript to a file. Printing �to a file�
results in ill-behaved PostScript that may not correctly print on other printers.
Instead, use the regular Save or Save As commands, which produce well-behaved
portable PostScript.
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12. Performance Issues

12.1. Understanding screen display

Displaying PostScript

Tailor uses its own proprietary engine to display the contents of PostScript docu-
ments on the screen. Essentially, the display engine renders the PostScript ob-
jects in an off-screen buffer, and then copies the result to the appropriate on-
screen window.

Display speed and screen depth (number of colors)

Tailor�s display engine is optimized for screen depths of 16 bits (thousands of col-
ors) and 32 bits (millions of colors) per pixel. For other screen depths (hundreds of
colors or less) Tailor�s display is a lot slower, mainly because of the need for dith-
ering (a mechanism to emulate a larger range of colors than is available on the
screen).

In the Preferences Panel, Editing pane there is an option called �Frequency of
Repaint updates�. If you set this option to �off� or �low� Tailor will perform much
better on screens with hundreds of colors or less.

Displayed graphics look fatter than printed graphics

Tailor uses the standard PostScript �fat fill� rule for displaying graphics. This rule
states that whenever a graphics object overlaps a pixel (no matter how small that
overlap may be), the pixel should be painted. On a high-resolution device such as
a printer or an image setter, the effect of fat fill is not too noticeable, since each
individual pixel is quite small. However, on a low-resolution device such as a
screen, it produces fat looking graphics, because pixels are much larger (typically
about 1/72 of an inch).

You can reduce the effect of fat fill on the screen by zooming in on a part of the
document (because, in essence, you increase the resolution at which the graphics
are displayed).

Note that the above remarks are equally valid for stroked lines as for filled areas.
Consequently, the fat fill effect is quite noticeable for narrow lines.

Text displays differently after it is rotated, or after zooming in

To display text in regular portrait or landscape orientations, Tailor uses bitmaps
acquired from Mac OS (i.e. Quickdraw or Adobe Type Manager). This ensures
that the characters are optimized for screen display, using all the �hints� the font
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designers have provided. However, if the text is rotated or otherwise transformed,
Tailor cannot use these bitmaps any more. Instead, Tailor paints the text by fill-
ing the appropriate character outlines.

As required by the PostScript standard, text outlines are filled using a �thin fill�
rule (as opposed to the fat fill rule described in the previous section). However,
Tailor does not use any hints provided in the font. This means that the text does
not look quite as good, especially for small point sizes.

If you zoom in so that the text is displayed at 130 point or more, Tailor stops us-
ing bitmaps and automatically switches to using outlines. For those sizes, the dif-
ference between both mechanisms is minimal anyway.

Embedded and available fonts display differently

Tailor can recognize and extract font information embedded in a PostScript file.
However, since those �embedded fonts� are not installed on your system, Tailor
cannot use the system-supplied bitmaps. Consequently, it always uses the outline
fill mechanism described in the previous section.

12.2. Understanding memory management

Memory consumption

Documents

Objects in a PostScript file may be compressed or otherwise represented in a very
compact form. To make the document editable, Tailor must expand that informa-
tion, and represent each object separately. Therefore, Tailor may need much more
memory than the size of the PostScript file would suggest. For example, it�s quite
possible that to load a 500KB file, Tailor needs several megabytes of memory.

Import

While importing a document, Tailor�s PostScript interpreter uses a substantial
amount of memory for temporary buffers and tables. This memory is freed once
the document has been fully imported.

Fonts

To speed up text display, Tailor caches font information. Especially embedded
fonts consume considerable amounts of memory.

Bitmap export

When exporting to a bitmap format (such as TIFF or GIF), Tailor builds the com-
plete image in memory before it is saved to file. For all but the lowest resolutions
this may require substantial amounts of memory.
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Virtual memory

When Tailor opens a PostScript file, it tries to load the complete document into
memory. If there is not enough memory available, Tailor saves one or more pages
of the document to a temporary file on disk, in a proprietary format. The saved
pages are automatically reloaded into memory when needed.

Saving and reloading pages slows down Tailor�s operation, but it allows process-
ing documents with many pages using only a reasonably small amount of mem-
ory.

Tailor�s �virtual memory� mechanism stores and reloads the contents of a com-
plete page at a time. This means Tailor�s memory allocation must be large enough
to contain at least the largest page of the document, plus the interpreter buffers,
plus any cached font information.

Reducing memory consumption

There are a number of things you can do to reduce memory consumption:

♦ Limit the number of opened documents.
♦ Avoid working with fonts that are not installed on your system. Using embed-

ded font information or text outlines consumes considerably large amounts of
memory.

♦ Reduce the maximum number of undoes (Preferences Panel, Editing pane).
Note that this setting only effects documents opened after the change has
been made.

♦ Avoid keeping large objects (such as pixel images) on the clipboard. To clear
the contents of the clipboard, select a simple object (such as a rectangle, or
short text segment) and choose the Copy command.

Allocating more memory to Tailor

To increase or decrease the size of Tailor�s memory allocation:

♦ Quit Tailor.
♦ In the Finder, locate the Tailor application, and select it.
♦ Choose the Get Info command in the Finder�s File menu.
♦ In the window that pops up, enter a new value in the �Minimum size� field

and/or in the �Preferred size� field.
♦ Close the info window.
♦ Restart Tailor.
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13. Menu Commands

13.1. File Menu

New

Creates a document window containing an empty untitled document. The page
size and orientation are determined by the Page Size settings in the Preferences
Panel, Document pane.

Open...

Brings up the Open File dialog so that you can locate the existing PostScript or
EPS document to be opened.

See also: User Guide, Opening and saving documents on page 28; User Guide,
Working with PS and EPS files on page 27  and User Guide, Setting import pref-
erences on page 49.

Close

Closes the current document window. If the document has been modified, an alert
panel gives you a chance to save or not to save the changes before closing the
document.

Save

Saves the current document under its current name. The first time you save a
document, Tailor always brings up the Save File dialog (see below) to avoid over-
writing the original PostScript or EPS file without confirmation.

Save as...

Brings up the Save File dialog to specify the name and location of the document.
The Save File dialog offers two Tailor-specific options, scope and format, described
below.

Lets you choose whether to save the complete document (all pages), the current
page or the current selection.

Lets you choose a file format. Choices are:
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♦ PostScript (PS).
♦ Encapsulated PostScript (EPS).
♦ Portable Document Format (PDF)
♦ Adobe Illustrator 3.
♦ Plain Text (ASCII).
♦ Formatted Text (RTF).
♦ PICT image.
♦ GIF image.
♦ TIFF image.

See also: User Guide, Opening and saving documents on page 28; User Guide,
Working with PS and EPS files on page 27 and User Guide, Setting export prefer-
ences on page 51.

Revert

Reloads the last saved version of the document, thereby undoing all edits since
the last save.

Document Setup

Brings up the Document Inspector, Page Size pane, which lets you modify the
page size and orientation for the current document.

See also: User Guide, Understanding printing on page 73 and Reference Manual,
Document Inspector on page 103.

Page Setup

Brings up the standard Page Setup panel, which lets you configure the physical
media to print this document on.

See also: User Guide, Understanding printing on page 73.

Print

Brings up the standard Print panel, which lets you print the current document to
a PostScript printer.

See also: User Guide, Understanding printing on page 73.

Quit

Causes Tailor to exit. If any open documents have been modified, an alert panel
gives you a chance to save or not to change the changes.
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13.2. Edit Menu

Undo

Undoes the effect of the last action.

Tailor provides multiple undoes. This means that you can go back multiple steps.
The maximum number of undoes per document is adjustable in the Preferences
Panel, Editing pane.

Redo

Redoes the last �undone� action.

Cut

Copies the current selection onto the Clipboard and then deletes the selection
from the document. See also Copy.

Copy

Copies the current selection onto the Clipboard. You can copy an arbitrary selec-
tion onto the clipboard and paste it into another Tailor document. Or you can se-
lect a column of text in Tailor and copy it to the clipboard as plain or styled text.

See also: User Guide, Copying and pasting graphical objects on page 46.

Paste

Pastes information from the clipboard into the current document. You can paste
an arbitrary selection of Tailor objects or you can paste a PICT into your Tailor
document. The PICT will be inserted as a regular pixel image.

See also: User Guide, Copying and pasting graphical objects on page 46.

Clear

Deletes the current selection without copying onto the clipboard.

Enter Group

Opens the currently selected group for editing. The function has the following ef-
fects:

♦ The group level indicator in the window toolbar increases by 1.
♦ Individual objects inside the group can be selected and edited.
♦ Objects outside the group are grayed and cannot be selected or edited.

See also: User Guide, Working with groups on page 43.
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Exit Group

Exits from the currently open group. The function has the following effects:

♦ The group level indicator in the window toolbar decreases by 1.
♦ Individual objects inside the group can no longer be selected and edited.
♦ Objects outside the group are no longer grayed and can be selected or edited

again.

See also: User Guide, Working with groups on page 43.

Edit Paths

Provides a submenu with commands that operate on paths or nodes. These com-
mands are described in a separate section below: Reference Manual, Edit Paths
Submenu on page 83.

See also: User Guide, Working with paths on page 41.

Edit Text Lines

Provides a submenu with commands that operate on text lines. These commands
are described in a separate section below: Reference Manual, Edit Text Lines
Submenu on page 85.

See also: User Guide, Editing objects on page 38, and User Guide, Working with
character glyphs on page 39.

Select Forward

Selects the next object in the current group, in forward direction.

Select Backward

Selects the next object in the current group, in backward direction.

Select Fw Local

Selects the next object in the current group and in forward direction whose
bounding box overlaps the bounding box of the currently selected object.

Select Bw Local

Selects the next object in the current group and in backward direction whose
bounding box overlaps the bounding box of the currently selected object.

Select All

Selects all objects in the current group.
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Deselect All

Deselects all selected objects. Does not change the group level.

See also: User Guide, Selecting objects on page 33, and User Guide, Working with
groups on page 43.

13.3. Edit Paths Submenu

See also: User Guide, Working with paths on page 41.

Begin Edit Nodes

Enters node-editing mode for the currently selected path or paths. In node-editing
mode you can perform the following actions:

♦ Select one or more nodes; you can use drag-select to select multiple nodes and
you can use the Shift key to select additional nodes.

♦ Move node(s) by dragging.
♦ Change the shape of a curve by dragging the curve�s control points.

To exit from node editing mode, click outside the selected path(s).

Shortcut to begin node editing: double click the selected path(s).

Insert Node

Adds a new node to the path. The new node is inserted into the path after the cur-
rently selected node.

Remove Node

Removes the currently selected node from the path.

Set Line Node

Changes the currently selected node to a line node. This makes the segment end-
ing in this node a straight-line segment.

Set Curve Node

Changes the currently selected node to a curve node. This makes the segment
ending in this node a curved segment. Since the first node of a path is always a
line node, you cannot apply this command to the first node of a path.

Smoothen Node

Aligns the Bezier control handles of a curved node. This makes the transition be-
tween the two segments connecting to this node a smooth one.
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Close Path

Connects the last node of an open path with the first node. The connection is al-
ways made using a straight line.

Open Path

Disconnects the first and last node of a closed path.

Reverse Path

Changes the order of the nodes in a path. This will have no visual effect for simple
paths but it can change the way composite paths are filled.

Insert Segment

Inserts a segment between the end nodes of two disjoint subpaths.

To join two separate path objects:

♦ Select both path objects and choose the Combine Subpaths command; the
paths are combined into one path but they are still disjoint subpaths.

♦ Double click the new combined path to enter node-editing mode.
♦ Select one end node of each subpath and choose the Insert Segment command.

The subpaths are now combined in a single path, connected by a new seg-
ment.

Remove Segment

Removes the segment connecting the currently selected nodes, which must be
adjacent nodes in the same subpath.

Split in Subpaths

Splits a path object containing multiple subpaths into separate path objects. The
objects keep their original attributes, but the splitting may affect the appearance
of filled paths.

Combine Subpaths

Combines two path objects into a single path object. The first path (i.e. the one in
the back) determines the attributes of the combined path. Even when the paths
have identical attributes, combining them may affect their appearance. For in-
stance, you can create a doughnut by combining two concentric circles and setting
the fill mode to eofill.
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13.4. Edit Text Lines Submenu

See also: User Guide, Editing objects on page 38, and User Guide, Working with
character glyphs on page 39.

Begin Edit Text

Enters text-editing mode for the currently selected text object. In text-editing
mode you can edit the text object using familiar text editing tools:

♦ Move the text cursor by clicking with the mouse or by using the left and right
arrow keys.

♦ Select a portion of text by dragging.
♦ Insert new text by typing.

To exit from text-editing mode, click outside the selected text or press Enter.

Notes:

♦ You can only begin editing a text object if it�s the only selected object.
♦ In PostScript, text is restricted to a single line; when you type, text will not

wrap into multiple lines.

Shortcut to begin text editing: double click the selected text object.

Add Glyphs

Brings up the Glyphs dialog for the text line currently being edited. The dialog
lists the names of all glyphs available in the text line�s font.

You can use the Glyphs dialog to add one or more glyphs by name, providing ac-
cess to glyphs that are not present in the standard character mapping. See User
Guide, Working with character glyphs on page 39.

Shortcut for bringing up the Glyphs dialog: press the Escape key.

Split in Words

Splits the selected text object into multiple text objects, each containing a single
word. This allows you to move or change a single word without affecting the posi-
tion of the other words.

Split in Characters

Splits the selected text object into multiple text objects, each containing a single
character. This allows you to move or change single character without affecting
the position of the other characters.
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Combine Text Lines

Combines the selected text line objects into a single text line. The new text line
gets the attributes of the first text line object in the list. Any changes in font, size
and other text attributes are lost.

Combining text on multiple lines results in a single line of text. This is because a
text object in PostScript can only be a single line.

Convert to Outlines

Converts the selected text line object(s) into path objects. After converting text to
paths, you can change the shape of individual characters, and you no longer need
the font to print the resulting PostScript file.

Tailor remembers the text in character form after conversion to outlines. This
makes it possible to revert to true text at any moment. See the Revert to Text
command below.

See also: User Guide, Understanding font handling on page 61.

Revert to Text

Reverts text that was converted to outlines to its original true text form. Any ed-
iting that was applied to the outlines is lost.

See also: User Guide, Understanding font handling on page 61.

13.5. Arrange Menu

Group

Combines the selected objects into a group.

Do not confuse this command with the Combine Subpaths command in the Edit
menu. The Group command combines objects into a group object, whereas the
Combine Subpaths command combines path objects into a single path object.

See also: User Guide, Working with groups on page 43.

Group with Mask

Combines the selected objects into a group, using the front-most object as a mask.
All parts of objects outside the mask become invisible (except in wireframe mode).

See also: User Guide, Editing and creating masks on page 45.

Ungroup

Ungroups the objects in the selected group.
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Bring Forward

Brings the selected object(s) one step more to the front.

Send Backward

Brings the selected object(s) one step more to the back.

Bring to Front

Make the selected object the front-most object.

Send to Back

Make the selected object the back-most object.

Insert Page

Inserts an empty page before the current page.

Add Page

Appends an empty page after the last page of the document.

Remove Page

Deletes the current page from the document.

13.6. View Menu

50% ... Other...

Sets the viewing scale of the current window. The viewing scale is shown on the
window toolbar.

Shortcut:  Use the viewing scale indicator  on the Window toolbar.

Zoom In

Magnifies the viewing scale by 2 from the center of the current window. The
maximum viewing scale depends on the documents page size. For a letter or A4
sized page, the maximum scale is about 2000%. For larger pages, the maximum
scale becomes proportionally smaller.

Shortcut: Use the Zoom In button  on the Window toolbar or press Command-
Plus.
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Zoom Out

Reduces the viewing scale by 2 from the center of the current window. The mini-
mum viewing scale is 5%.

Shortcut: Use the Zoom Out button  on the Window toolbar or press Com-
mand-Minus.

Fit In

Sets the viewing scale to fit the current page in the window.

Wireframe

Toggles wireframe mode on and off.

Shortcut: Use the Wireframe button  on the Window Toolbar.

See also: User Guide, Viewing a document on page 32.

Center Selection

Changes the view to center the selection on the screen. By centering the selection
you can keep the selection in the window while zooming in.

Previous Page

Displays the previous page of the document. The page number is shown in the
window toolbar.

Shortcut: Use the Previous Page button  on the Window Toolbar.

Next Page

Displays the next page of the document. The page number is shown in the window
toolbar.

Shortcut: Use the Next Page button  on the Window Toolbar.

Go to Page

Brings up a dialog box in which you can enter the desired page number. The page
number is shown in the window toolbar.

Shortcut: Use the Page Number button  on the Window Toolbar.
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13.7. Windows Menu

Top section

Lists all available floating panels:

♦ Toolbox.
♦ Graphic Inspector.
♦ Document Inspector.
♦ Color Mixer.
♦ Font Picker.
♦ Preferences Panel.

Choose one of these menu commands to bring up the corresponding floating
panel, or to bring it to the front. Panels that are currently on screen have a check
mark next to the corresponding menu command.

When you start Tailor, the floating panels specified in the Preferences Panel,
Startup pane, open automatically. The panels are positioned where you left them
in your previous session.

Bottom section

Lists all open document windows. The currently selected window has a check
mark. You can bring another document window to the front by choosing it from
the list.

13.8. Shortcut keys

The table below provides an overview of Tailor�s shortcut keys. For more details
on the operation of each key, see the corresponding menu command or tool.

Shortcut key Com-
mand

Description

Command-A Select All Selects all objects in the current group.

Command-C Copy Copies the selection onto the clipboard.

Command-D Deselect
All

Deselects all objects in the current docu-
ment.

Command-E Wireframe Toggles between preview and wireframe
mode.

Command-F Fit In Sets the viewing scale to fit the current
page in the window.
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Command-G Group Creates a group that contains the selected
objects.

Command-H 100% Sets the viewing scale to 100%.

Command-I Other Pops up a dialog to set the viewing scale to
a custom value.

Command-N New Opens a new document.

Command-O Open Opens an existing document.

Command-P Print Print the current document.

Command-Q Quit Exits from Tailor.

Command-S Save Saves the current document.

Command-U Ungroup Ungroups the selected group.

Command-V Paste Pastes the contents of the clipboard into
the current document.

Command-W Close Closes the current file.

Command-X Cut Removes the selected objects from the
document and places them on the clip-
board.

Command-Z Undo Undoes the last change you made to the
current document.

Command-Plus Zoom In Zooms in on the current document.

Command-
Minus

Zoom Out Zooms out on the current document.

Command-
Period

- Aborts loading of a document.

Command-1 Selects the Selection tool.

Command-2 Selects the group-transparent selection
tool.

Command-3 Selects the Viewport tool.

Command-4 Selects the Rectangle drawing tool.

Command-5 Selects the Ellipse & Circle drawing tool.
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Command-6 Selects the Path drawing tool.

Command-7 Selects the Text creation tool.

Command-8 Selects the Rotation tool.

Command-9 Selects the Scaling tool.

Command-0 Selects the Shearing tool.

Backspace Clear Deletes the selected objects without copy-
ing them onto the clipboard.

Delete Clear Deletes the selected objects without copy-
ing them onto the clipboard.

Escape Add
Glyphs

While editing a text line, brings up the
Glyphs dialog with glyph names for the
text line�s font.

Arrow keys - Nudges (i.e. moves) the current selection in
the appropriate direction pixel by pixel.

13.9. Modifier keys

Modifier keys can be pressed while clicking or dragging to obtain an optional ef-
fect.

Shift key

Press the shift key while clicking to add or remove objects to the current selection
without deselecting the current selection.

See also: User Guide, Selecting objects on page 33.

Option key

Press the option key while dragging with many of the tools (move, rotate, etc.) to
constrain the transformation in a certain way.

See also: User Guide, Moving, scaling, rotating and shearing visually on page 35
and Reference Manual, Toolbox on page 93.
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14. Windows & Panels

14.1. Window Toolbar

You can find the Window Toolbar at the bottom of every document window. It
provides shortcuts for frequently used actions.

Viewing Scale selector 

Click and drag to select another viewing scale for your document.

Zoom In button 

Click to zoom in by a factor of 2.

Zoom Out button 

Click to zoom out by a factor of 2.

Wireframe Mode button 

Click to switch between wireframe mode and preview mode.

Enter Group button 

Click to enter the currently selected group, if any. All objects outside of the en-
tered group become dimmed (grayed). You can edit the objects inside the group
without affecting the rest of your document.

Group Level indicator 

Displays the current group level.

Exit Group button 

Click to exit the group.

Page navigation buttons 

Use these buttons to go to different pages on your document. The left and right
arrows will take you to the previous or next page. You can see the current page
number and the total number of pages in your document in the page indicator
button between the arrows. You can also click on this indicator to go to a specific
page.



Tailor 2.0 � Reference Manual

93

14.2. Toolbox

Toolbox tools determine the action Tailor takes when you click or drag the mouse
in a document window. Only one tool can be active at any time.

Selection tool 

This is the default tool. Its main purpose is to select the object(s) you want to edit.
It also allows moving objects and opening objects for editing.

♦ Click on any visible part of an object to select it.
♦ Shift-click an object to add it to or remove it from the selection.
♦ Drag a rectangle to select all objects that overlap with the dragged area.
♦ Press the Option key and drag a rectangle to select only those objects that lie

fully inside the dragged area.
♦ Drag any object to move the selected set.
♦ Drag any selection handle to resize the selected set. Press the Option key be-

fore dragging to constrain the new size to multiples of the original size.
♦ Double-click on a group to enter the group. See also: User Guide, Working

with groups on page 43.
♦ Double-click on a text or path object to start editing it. See also: User Guide,

Editing objects on page 38.

You can only select objects in the current group. See User Guide, Working with
groups on page 43.

See also: User Guide, Selecting objects on page 33.

Group-transparent selection tool 

This is a special variant of the Selection tool described above. It allows you to di-
rectly select any object, regardless of the group in which it is contained and re-
gardless of the group in which you are currently working.

The group-transparent selection tool supports all functions of the normal selection
tool, except for rectangle selection.

See also: User Guide, Working with groups on page 43.

Viewport tool 

The Viewport tool allows zooming in on a specific area. Drag a rectangle in the
document window. The dragged area magnifies to fill the entire window. The
zoom scale is reflected in the window toolbar.
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Rectangle drawing tool 

Allows drawing rectangles and squares. Drag to draw a rectangle; press the Op-
tion key before dragging to constrain to a square.

Use the Graphic Inspector to change graphic attributes.

Ellipse & Circle drawing tool 

Allows drawing ellipses and circles. Drag to draw an ellipse; press the Option key
before dragging to constrain to a circle.

Use the Graphic Inspector to change graphic attributes.

Path drawing tool 

Allows creating new paths: each mouse click in the document window will add a
new node to the path. To finish the path, select another tool from the Toolbox.

Use the Graphic Inspector to change graphic attributes.

See also: User Guide, Working with paths on page 41.

Text creation tool 

Allows creating a text line. Click in the document window to indicate the position
of the text line, then enter the text.

Use the Graphic Inspector to change font, size and other graphic attributes.

See also: User Guide, Working with character glyphs on page 39.

Rotation tool 

Rotates the selected object or selection of multiple objects around the center of the
selection. Drag the mouse to rotate.

Press the Option key before dragging to constrain to multiples of 15 degrees (you
can change the constrain angle in the Preferences Panel, Editing pane).

Tip: Drag sufficiently far from the center of rotation for better accuracy and con-
trol.

Scaling tool 

Scales the selected object or selection of multiple objects around the center of the
selection. Drag the mouse to scale.

Press the Option key before dragging to constrain to multiples of the original size.
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Tip: Drag sufficiently far from the center for better accuracy and control.

Shearing tool 

Shears (skews) the selected object or selection of multiple objects around the cen-
ter of the selection. Drag the mouse to scale.

Press the Option key before dragging to constrain to multiples of 15 degrees (you
can change the constrain angle in the Preferences Panel, Editing pane).

Tip: Drag sufficiently far from the center for better accuracy and control.

14.3. Graphic Inspector

Attributes pane

The Attributes pane displays all relevant attributes for the currently selected ob-
jects, depending on their type. Nearly all attributes can be modified.

If an attribute does not have the same value for all selected objects, a wildcard
indicator appears. When you enter a new value over a wildcard attribute, all se-
lected objects are affected.

Object Type

Lists the number of selected objects and their type, if they all have the same type.

Color

Shows the color and the color space such as CMYK. If the color space is spot color,
the following information appears:

♦ Identification number of the spot color in the Spot Color pane of the Docu-
ment Inspector.

♦ Tint percentage of the color.

To apply a new color to the selection, drag a color from the Color Mixer to the
Graphic Inspector. You can also drag in the reverse direction to place an existing
color in the Color Mixer.

Shortcuts: to apply a new color to the selection, double click the color field in the
Color Mixer; to set the Color Mixer�s color, double click the color field in the
Graphic Inspector.
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Overprint

Shows the state of the overprint attribute.

Font

Shows the font of a text line.

If Tailor performed font substitution, two names appear:

♦ The font that Tailor uses to display the text, followed by a �<<� sign.
♦ The original font name specified in the PostScript document.

See also: User Guide, Setting import preferences on page 49, and User Guide,
Understanding font handling on page 61.

Use the Font Picker to change the font. Press the Picker button to bring it up.

Picker...

Brings up the Font Picker. To change the font, click on the desired font in the
Font Picker panel, and then press Apply.

Size

Shows the font size of a text line in points. Use the arrows to change the size in 1-
point increments, or enter a new value.

Tracking

Shows the amount of tracking in points applied to the characters in the selected
text line. In PostScript, tracking is specified by a horizontal (x) and vertical (y)
component. For Roman scripts, the vertical component almost always equals zero.

Shows the amount of tracking applied to all characters in the text line. Use the
arrows to change a tracking component in 0.01-point increments, or enter a new
value.
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Shows the amount of tracking applied to a �special� character in the text line. Use
the arrows to change a tracking component in 0.1-point increments, or enter a
new value.

In most cases, the �special� character is the space. To specify another �special�
character, simply enter the character itself in the field provided, or type its com-
plete glyph name. See User Guide, Working with character glyphs on page 39.

Stroke/Fill

Indicates whether a path is stroked or filled.

A path is either stroked or filled. It cannot be stroked and filled at the same time.
If a stroke and a fill are visible in the document for apparently the same path, the
document contains two consecutive paths, one stroked and one filled. Click in the
filled area to inspect the fill attributes; click in the stroked area to inspect the
stroke attributes.

Fill Type

Indicates the fill rule used to fill the path.

♦ Fill uses the Non-Zero-Winding fill rule.
♦ Eofill uses the Even-Odd fill rule.

The fill rule becomes relevant if a path is self-intersecting or if it consists of more
than one subpath.

Width

Indicates the width of a stroke using the units selected in the Preferences Panel,
Editing pane. Use the arrows to change the width incrementally, or enter a new
value.
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Uniform stroke

Indicates whether a path has a uniform stroke.

Cap

Indicates the line cap, i.e. the way in which the ends of an open path are drawn.
From left to right, the choices are butt, round and square.

Join

Indicates the line join, i.e. the way in which the connections between line seg-
ments in a path are drawn. From left to right, the choices are miter, round and
bevel.

Miter limit

Indicates the miter limit, i.e. the maximum length of mitered line joins.

Dash pattern

Specifies a dashed stroke as a series of  �on� and �off� lengths using the units se-
lected in the Preferences Panel, Editing pane. The dash offset specifies where in
the dash sequence the dashing of a path starts.

Pixel image information

Displays attributes for a pixel image, including size in pixels, pixel depth, and
color space. These attributes cannot be modified.
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Polarity

Indicates the polarity of a transparent single-bit pixel image. When you reverse
the polarity, painted pixels become transparent and vice versa.

Mask enabled

Indicates whether the mask of a group with mask is enabled or not. If a mask is
disabled, it is no longer used to hide parts of the objects in the group.

Mask type

As is the case with the fill attribute for a path, the inside-ness of a mask is gov-
erned by its fill type. The fill type can be Fill (non-zero winding) or Eofill (even-
odd).

Group info

The group info field shows information about a group in free text form.

Tailor automatically produces groups when importing a PostScript file:

♦ Every page of a PS document is turned into a group.
♦ Every embedded EPS image in a PostScript file becomes a group.

For those automatically created groups, Tailor extracts useful information from
the PostScript file (structured comments), such as the program used to create the
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PostScript code, the creation date and the name of the document. This informa-
tion is displayed in the group info field.

For manually created groups, you can enter any descriptive text to identify the
group. Press the OK button to terminate editing the text in the group info field.

OPI file paths

Displays one of two file paths associated with the selected OPI group. Depending
on the selected radio button, the text field shows one of the following file paths:

♦ Image File Name.
♦ Image ID.

You can edit the file path currently displayed in the text field. Press the OK but-
ton to terminate editing.

The exact syntax and meaning of these file paths depend on the specific OPI
server in your workflow. Do not edit the file paths unless you know exactly what
you are doing.

OPI file path re-link button

Re-links the file path currently displayed in the file path text field, using a stan-
dard Mac OS Open File dialog.

The new file path is entered in the text field using standard Mac OS syntax. This
may or may not work with the specific OPI server in your workflow. Do not re-
link the file paths unless you know exactly what you are doing.

OPI preview image delete button

Removes the low-resolution preview image from the selected OPI group.

OPI image size
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Displays the image size for the selected OPI group, in pixels. This attribute can
not be modified.

OPI crop box

Indicates the crop box for the image in the selected OPI group, expressed in pix-
els. Click one of the arrow buttons to modify the crop box incrementally, or enter
a new value in one of the fields.

Position pane

Object Type

Lists the number of selected objects and their type, if they all have the same type.

Lower left, Size, Upper Right

Indicates position and size of the selection. These fields are editable for numeric
adjustment of position and size.

You can select the units used for these values in the Preferences Panel, Editing
pane.

Aspect Ratio

Indicates the amount of non-uniform scaling. A value of 1 indicates uniform scal-
ing. The aspect ratio is equal to the horizontal scale divided by the vertical scale.

Angle

Indicates the rotation angle in degrees, counterclockwise (0 = no rotation).
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Numeric Scale & Rotate

These are convenience controls for easier scaling and rotation:

♦ Numeric field for uniform scaling.
♦ Numeric field for rotation (positive counterclockwise).
♦ Buttons for scaling x2 and /2.
♦ Buttons for mirroring (horizontal, vertical).
♦ Button for rotation over 90 degrees clockwise and counterclockwise.

Statistics pane

The Statistics pane provides statistics on the objects in the current selection.

Include objects inside groups

This option determines whether Tailor includes objects inside groups (down to the
lowest nesting level) in the statistics.

Statistics for Graphics

For paths: the total number of paths in the selection and the number of nodes in
the longest selected path.

For text lines: the total number of text lines in the selection and the number of
characters in the longest selected text line.

For pixel images: the total number of pixel images in the selection and the num-
ber of bytes occupied by the largest selected pixel image.
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Statistics for Groups

For groups: the number of masked and unmasked groups and the number of ob-
jects in the largest group.

14.4. Document Inspector

Page Size pane

Page Size

Indicates the size of the pages in the document using the units selected in the
Preferences Panel, Editing pane. All pages in a Tailor document have the same
size and orientation.

To modify the page size, select the name of a standard size from the popup menu,
or enter a new (custom) value for the page width or height.

See also: User Guide, Understanding page size on page 71.

Orientation

Indicates the orientation of the pages in the document. To modify the orientation,
press the appropriate portrait or landscape button, or type a new value for the
page width or height.

When you change the page orientation, Tailor leaves you the option to automati-
cally rotate the contents of all pages in the document accordingly. A dialog win-
dow presents three choices: Rotate Left, Rotate Right, or Don�t Rotate.
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Rotate Now

These action buttons change the page orientation, rotating the contents of all
pages in the document in the indicated direction, without asking further confir-
mation. From top to bottom, the buttons represent Rotate Left, Turn Upside
Down, and Rotate Right.

Spot Colors pane

The Spot Colors pane lists all spot colors used in the current document. If appli-
cable, the list includes spot colors used in embedded EPS images as well.

You can drag a spot color to the Color Mixer and back, and you can change the
name of a spot color. If you modify a spot color, all objects painted (stroked or
filled) in that color change color.

To add a new spot color to the list, click the down-arrow button at the bottom of
the list.

See also: User Guide, Working with spot colors, on page 66.

Import pane
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Displays error or warning messages generated while importing (opening) a docu-
ment. The number between parentheses indicates the number of times the error
or warning occurred.

For a description of the messages, see Reference Manual, Errors and Warnings on
page 118.

Export pane

Displays error or warning messages generated while exporting (saving) a docu-
ment. A warning means that the output file may not exactly reflect the saved
document. The number between parentheses indicates the number of times the
error or warning occurred.

For instance, Illustrator 3 format does not support the even-odd fill rule (eofill).
When exporting an object filled using eofill, Tailor must convert the eofill attrib-
ute to fill. In some cases this can cause a different rendering of the object.

For a description of the messages, see Reference Manual, Errors and Warnings on
page 118.

14.5. Color Mixer

Color Models

The Color Mixer allows you to create color according to five different color models.

Color wheel

 Drag to a hue/saturation location on the color wheel, and adjust the slider to
specify brightness. Note that the color wheel model actually generates RGB color.

Gray

 Adjust the slider or enter a value in the numeric field to specify a gray level.

RGB

 Adjust the sliders or enter values in the numeric fields to specify a color.
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CMYK

 Adjust the sliders or enter values in the numeric fields to specify a color.

Spot Color

 Drag a color from the Spot Color pane (Document Inspector) to the color field
and adjust the tint using the slider or the numeric field. See User Guide, Working
with spot colors on page 66.

Operation

Color field

The color field shows the color that you are currently mixing.

The Color Mixer�s color field is not automatically updated to the color shown in
the Graphic Inspector, but you can drag a color from the Graphic Inspector to the
Color Mixer and then modify it.

Apply button

To apply a color from the Color Mixer to the selected object(s), press the Apply
button, double click the Color Mixer�s color field, or drag the color to the Graphic
Inspector.

See Reference Manual, Graphic Inspector on page 95.

Color conversion

When you switch to a different color model, Tailor converts the color in the color
field to the new color model. However, this conversion is not always exact. In par-
ticular, conversion from RGB to CMYK and vice versa is only an approximate.

14.6. Font Picker

The Font Picker shows a list of all fonts available to Tailor, and displays some at-
tributes of the �picked� font, i.e. of the font currently selected in the list.

For advanced information on fonts, see User Guide, Understanding font handling
on page 61.
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Font Family and Style

 

The leftmost column lists all available font families, in alphabetical order. When
you select a particular family, the rightmost column lists the styles available for
that family.

Include

Turn off any of these check boxes to exclude fonts of the corresponding type from
the list.

♦ System fonts: fonts installed on your computer.
♦ Embedded fonts: fonts extracted from files that have been imported in Tailor.
♦ Unavailable fonts: fonts that are not available to Tailor, and which conse-

quently have been substituted by another font.

Attributes

When you select a particular font (i.e. family and style), the Attributes section
displays some of the font�s attributes.

System fonts

Indicates whether the system font is a TrueType font or an Adobe Type 1 font.
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Embedded fonts

Indicates whether the embedded font is a TrueType font or an Adobe Type 1 font,
and also shows the name of the file from which the font was extracted.

Click the Delete button to remove the embedded font from Tailor�s internal li-
brary. Note that all embedded fonts are removed from the internal library when
quitting Tailor.

Unavailable fonts

Indicates the substitution font in use for the unavailable font, and the substitu-
tion font�s type (TrueType or Adobe Type 1).

Click the Set button to modify the substitution font for this particular unavailable
font. A dialog appears that lists all available system fonts, in a manner similar to
the Font Picker. Select one of the listed fonts, and click OK to use that font as the
new substitution font.

The Substitution Font dialog
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The substitution relations created in this manner are preserved between Tailor
sessions. In effect, this means you can maintain a �substitution table� for unavail-
able fonts.

Applying

To apply a font to a text object, select the font family and style in the font picker
and press the Apply button. Alternatively, you can double click the font name or
style.

14.7. Preferences Panel

You can customize Tailor to your own preferences using the Preferences Panel.
Your changes take effect immediately, and Tailor automatically saves your pref-
erences.

For information on which preferences are relevant for importing from or export-
ing to a particular format, see User Guide, Setting preferences on page 49.

Note: the screen grabs show the factory default preference settings.

Import Fonts pane

Font usage and ordering

When importing text set in a particular font, Tailor can look for the corresponding
font information in several ways:

♦ System fonts: the fonts installed on your computer.
♦ Embedded fonts from this file: any fonts embedded in the file currently being

imported.
♦ Embedded fonts from other files: any fonts embedded in (and extracted from)

a file previously imported in Tailor during the current session. The embedded
fonts database is cleared each time you launch Tailor.

♦ Outlines: use fonts embedded in the file currently being imported to convert
the text to outlines.
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By turning the appropriate checkboxes on or off, you can specify which of these
font information sources Tailor should use.

Tailor searches the font information sources in the order listed. For example, with
the settings shown in the example, if the font Helvetica is both embedded in the
file being imported and installed on the system, Tailor will use the system font
and ignore the embedded font.

By clicking the arrow button, you can modify the order in which system and em-
bedded fonts are searched. Thus you can use the font embedded in a file, even if a
font with the same name is installed on your computer.

For more in-depth information on font handling, see User Guide, Understanding
font handling on page 61.

Default substitution font

If none of the �allowed� font information sources described above can satisfy the
search for a particular font, Tailor substitutes the originally specified font by an-
other font.

To set the default substitution font, click the Set� button and select one of the
fonts listed in the dialog box that appears.

In addition, the Font Picker allows you to set a specific substitution font for a par-
ticular unavailable font. These �substitution� relationships are preserved between
Tailor sessions. For more information on the Font Picker, see Reference Manual,
Font Picker on page 106.

For more in-depth information on font handling in general, see User Guide, Un-
derstanding font handling on page 61.

Import Other pane

Reconstruct page breaks

Turn on the �Reconstruct Page Breaks� check box to make Tailor insert page
breaks at the locations indicated by the structured comments in the imported file.
This may be necessary for PostScript files that do not properly execute the �show-
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page� PostScript operator at the end of each page. On the other hand, with some
PostScript files it may cause unwanted extra page breaks.

Generally, you should leave this option turned off.

Reconstruct spot colors

Turn on the �Reconstruct Spot Colors� check box to make Tailor convert process
colors to spot colors, where appropriate. This may be necessary for PostScript files
that do not use the proper operators for setting spot color. On the other hand,
with some PostScript files it may cause some process colors to be converted to spot
colors inadvertently.

Generally, you should leave this option turned off.

Emulated Resolution

PostScript is designed to be device independent. Therefore a page description
should never assume a particular device resolution. Unfortunately, some drivers
generate questionable PostScript that does rely on device resolution. In such cases
it may be necessary to set the emulated resolution field to the resolution of the
target device. Tailor will then behave like a device that has this resolution.

Export Fonts pane

Original or Substituted font name

Specifies the font attribute that Tailor uses in the output file when saving a text
object in a substituted font.

♦ Export original font name: Tailor uses the original font name specified in the
input file.

♦ Export substituted font name: Tailor uses the name of the substitution font.

See User Guide, Understanding font handling on page 61.
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Include fonts

Specifies which fonts should be included (embedded) in the output file.

♦ None: no fonts are included in the saved document.
♦ Embedded only: only fonts marked as �embedded� in the Font Picker are in-

cluded in the saved document.
♦ All but standard 13: if a font is one of the standard 13 fonts most PostScript

printers have built in, it is not included. Otherwise it is included.
♦ All: all fonts are included.

Export PS pane

Mask around page

When this checkbox is turned on, Tailor places a mask around each exported
PostScript page, exactly at the page borders. The latter ensures that nothing is
being painted outside the page borders. On the other hand, the mask cuts off any
�bleeds� that may have been placed outside the page borders on purpose.

See User Guide, Understanding page size on page 71.

Image format & compression

Pixel images embedded in a PostScript file can be written in one of the four fol-
lowing formats:

♦ Uncompressed Hexadecimal text
♦ Uncompressed Binary data
♦ LZW compressed ASCII85 text
♦ LZW compressed Binary data
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The LZW compressed formats result in (considerably) smaller files, but they can
only be printed on PostScript level 2 printers.

The binary formats result in smaller files as well, but they can not be transported
over 7-bit ASCII communication channels, and may not be fully portable across
different computer platforms.

Export EPS pane

Include showpage, center on page

Include showpage operator: specifies to include a showpage command in the EPS
file. This is required by the EPS standard but some programs malfunction if it is
present.

Center image on page: specifies to position the saved EPS image in the center of
the current �default� page, rather than in the lower left corner. The default page
size can be specified in the Preferences Panel, Document pane. Centering an EPS
image is useful when you want to print the EPS file on its own, using a PostScript
downloader.

With most page layout applications, centering an EPS image does not affect the
program�s ability to correctly place the image.

Bounding Box

Page layout applications use the bounding box of an EPS image to calculate the
size of the image and to correctly position the image on a page.

Generally, the bounding box corresponds exactly to the intrinsic image size. How-
ever, in some circumstances, it may be useful to add extra space to one or more
sides of the image.

When this preference is set to �Use image size�, Tailor calculates the intrinsic size
for the exported image, and uses that size as the EPS bounding box. When it is set
to �Use page borders�, Tailor uses the page borders provided by the user instead.

See User Guide, Understanding page size on page 71.
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Preview image

An EPS file typically includes a low-resolution preview image. Page layout appli-
cations use this preview to display the image on the screen, since they lack the
PostScript interpreter necessary to display the EPS image itself. The low-
resolution preview is discarded for printing.

Tailor provides three options:

♦ No preview: this somewhat reduces EPS file size, however it is not recom-
mended.

♦ Include PICT preview: this is the preview format used on Mac OS; it is not
compatible with other platforms.

♦ Include TIFF preview: this is a preview format supported by most applica-
tions on most platforms, including Mac OS and Windows.

Export PDF pane

Format

Select Binary to generate more compact PDF files. Select ASCII to optimize
transportability over 7-bit communication channels and across platforms.

Compression

Turn the checkboxes on or off to select compression for PDF page descriptions
(�Text and Line Art�) and/or out-of-line pixel images (�Images�).

Export Raster pane

PICT
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The text field specifies the resolution of the exported PICT image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

GIF

The text field specifies the resolution of the exported GIF 89a image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

Turn on the check box to produce an interlaced GIF file. Most web browsers sup-
port �gradual updating� when downloading an interlaced GIF file.

GIF 89a files are always LZW compressed.

TIFF

Use the radio buttons to select RGB or CMYK color space for the exported TIFF
file. Tailor converts colors to the target space using a very simple (and not very
accurate) algorithm. Older TIFF readers may not support the CMYK color space.

The text field specifies the resolution of the exported TIFF image in pixels per
inch. Note that saving large images at high resolutions requires large amounts of
memory.

Turn on the check box to use LZW data compression, resulting in a smaller file.
Older TIFF readers may not support LZW compression.

Export Other pane

Line Separator

Specifies which line separator convention Tailor should use in saved files. You can
select Mac OS (CR), DOS (CRLF), or Unix (LF). Though PostScript printers and
Adobe Acrobat Viewers accept all three conventions, files may be more easily
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transportable to other platforms by selecting the appropriate line separator con-
vention.

Document pane

Default page size and orientation

Specifies the page size and orientation for documents that do not contain any
page size information.

See User Guide, Understanding page size on page 71.

Document window location and size

Defines the initial size and position of the first document window Tailor opens.

Move and resize a document window as desired, and click the Grab button to copy
that size and position.

Document window displacement

Specifies the displacement between the first document window Tailor opens, and
subsequent document windows. The displacement is specified in pixels.

Editing pane

Frequency of repaint updates

While rendering (painting) the contents of a document window, Tailor updates the
screen a number of times per second. You can set the frequency of those updates
from low to high or you can choose to switch updating off, in which case Tailor
only updates the screen when rendering is complete.
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Switching updating off is recommended on slower systems or on screens that don�t
support at least thousands of colors.

Measurement units

Defines the measurement units used in the inspector panels. You can choose be-
tween points, picas, inches, centimeters and millimeters.

Maximum number of undoes

Defines the maximum number of operations Tailor can undo. A larger value con-
sumes more memory.

Copy/Paste displacement

Defines the position of a pasted object relative to the original (copied) object when
pasting into the same page. The displacement is specified in pixels.

Rotate constrain angle

Defines the step of the rotation or shearing angle when rotating or shearing using
the mouse while you press the Option key.

Color pane

Specifies the color of the background, the selection control handles etc.

Use the Color Mixer to define a color. You can drag colors from the Preference
Panel back and forth to the Color Mixer. Do not press the Apply button in the
Color Mixer since this would cause the selected object(s) to change its color.
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Start up pane

Turn on a check box if you want the corresponding panel to appear when you
start Tailor. Note that Tailor remembers the previous position of each panel.

License pane

If your copy of Tailor is already licensed, this pane shows the type of your license,
your serial number and your personalization info.

For information on how to register your license string, see Getting Started, Li-
censing Tailor on page 4.

14.8. Errors and Warnings

These messages will appear in the Document Inspector if anything goes wrong
while importing or exporting a file. Tailor Converter shows these error messages
as well (see User Guide, Using Tailor Converter on page 68).

A number between parentheses at the end of a message indicates the number of
times the error or warning occurred

Import messages

PostScript error xxxx in yyyy

Tailor detected a PostScript language error while importing the document.

Import aborted after xxxx PostScript error(s)

After a certain number of PostScript errors Tailor stops importing the document.

Import aborted by User

You pressed Command-Period to abort importing the document. The part of the
document that was already processed will be displayed and is fully editable.
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Import aborted because memory was full

Tailor doesn�t have enough memory to load the document. The part of the docu-
ment that was already processed will be displayed. See User Guide, Understand-
ing memory management on page 75.

Font "xxxx" substituted by "yyyy"

The font specified in the PostScript file is not available on your system, and is re-
placed by a different font. Tailor offers several options to help avoid this situation.
See User Guide, Setting Import Preferences on page 49, and User Guide, Under-
standing font handling on page 61.

CIE based color component used as device gray
CIE based color component used as device RGB

Tailor encountered a CIE color in the PostScript document. The CIE color system
is a PostScript level 2 feature used to implement a device independent color space.
This is not supported by the current version of Tailor. These colors are substituted
by device gray or device RGB colors. In most cases the substituted colors will bear
no resemblance to the intended colors at all.

Separation color substituted by 50% gray
Pattern color substituted by 50% gray

Tailor encountered a Separation color or a Pattern color in the PostScript docu-
ment. These PostScript level 2 features are currently not supported by Tailor.
These colors are simply substituted by a 50% gray.

Export messages

Export failed: i/o error while writing file

A device i/o error or access rights error occurred while saving the file. This can
occur for a number of reasons: a disk may be read-only, there may be too little
space left on the disk to store the complete file or you may not have write-
permission for the specified location.

Export aborted because memory was full (xxxx bytes needed)

The export operation failed because Tailor could not allocate the memory needed
for temporary buffers. This can only happen while exporting to a pixel image for-
mat (PICT, GIF, or TIFF). The error message mentions the amount of memory
needed, so that you can adjust Tailor�s memory allocation accordingly. See User
Guide, Understanding memory management on page 75.
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Pixel image ignored

You exported a file to Adobe Illustrator 3 format. This format does not support
embedded pixel images (bitmaps). If there are bitmaps in your document, they are
simply ignored.

RGB color converted to CMYK

You exported a file to Adobe Illustrator 3 format. The RGB color space is un-
known to Adobe Illustrator 3. Thus all RGB colors in your document are con-
verted to CMYK. The resemblance of the converted colors is only an approximate.
If you want to be sure your colors are exported correctly, use CMYK colors in
Tailor.

Even-odd fill replaced by non-zero-winding fill

You exported a file to Adobe Illustrator 3 format. Adobe Illustrator 3 only sup-
ports the non-zero-winding fill rule thus all even-odd fills in your document are
converted to non-zero winding fills. This is only a warning, it doesn�t necessarily
mean that the appearance of the converted object will change. The difference be-
tween the two fill rules typically only matters if a path is self-intersecting or con-
sists of multiple subpaths.

Non-uniform stroke replaced by uniform stroke

You exported a file to Adobe Illustrator 3 format. Non-uniform stroked paths are
not supported by Adobe Illustrator 3. They are replaced by uniform stroked paths.

Vertical tracking in text line ignored

You exported a file to Adobe Illustrator 3 format. Vertical tracking is a PostScript
feature not supported by Adobe Illustrator 3. It is ignored when exporting to this
format.

Tracking for character "a" ignored

You exported a file to Adobe Illustrator 3 format. PostScript supports tracking for
specific characters but Adobe Illustrator 3 doesn�t. The character specific tracking
is ignored when exporting to the Illustrator 3 format.

Dash pattern of length xxxx truncated to length 6

You exported a file to Adobe Illustrator 3 format. In this format, dash patterns
have a maximum length of 6. Longer dash patterns are truncated.
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15. License Agreement

By registering your license string in Tailor�s License Panel, you accept the terms
of the License Agreement listed below.

15.1. License agreement

Tailor for Mac OS and all related documentation (together called "the software")
is copyrighted according to the copyright notices on the About Panel.

You are not authorized to use the software unless you lawfully obtained an origi-
nal Software License String from EnFocus Software NV. By registering the Soft-
ware License String in the License Panel, or by using the software, you agree to
be bound by the terms of this agreement.

You need to complete and return the supplied User Registration Card to become a
registered authorized user.

This license agreement does not constitute a sale of the software or any copy
thereof.  You are granted a personal, nontransferable, and nonexclusive right to
use a single copy of the software on a single computer.

EnFocus Software NV and its suppliers retain all title to the software and all
copies thereof. No title to the software, or any intellectual property in the soft-
ware, is transferred.

You agree not to reverse engineer, decompile or otherwise attempt to derive
source code from the software.

EnFocus Software NV and its suppliers are intended third party beneficiaries of
this license agreement, and are each entitled to enforce it in their own name
against the licensee.

EnFocus Software NV and its suppliers will not be liable for any general, special,
direct, indirect, consequential, incidental, or other damages arising out of the li-
cense of the software, even if they have been advised of the possibility of such
damages.

EnFocus Software NV and its suppliers make no warranties, express, implied or
statutory, regarding the software, including without limitation the implied war-
ranties of merchantability and fitness for a particular purpose, or their equivalent
under the laws of any jurisdiction.

If, for any reason, you return any materials to your point of sale or to EnFocus
Software NV, you bear the risk of loss, misplacement or damage of said materials.
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In the event of continued disagreement as to the interpretation or performance of
this agreement, the parties expressly assign jurisdiction to the courts and tribu-
nals of the juridical district of the EnFocus Software NV head office.

This agreement shall constitute the entire agreement between the parties with
respect to the subject matter hereof, and supersedes any prior agreements or un-
derstandings between the parties, whether written or oral, with respect hereto.

15.2. User registration Card

Please complete a user registration card, and return it to your reseller or to EnFo-
cus Software. You will be informed about new Tailor related developments, and it
ensures that you are eligible for special upgrade prices offered to registered users.

You can:

♦ Use the printed card provided with your software package.
♦ Use the electronic form provided below and e-mail, mail or fax it.

15.3. Tailor User Registration Form
Product:        Tailor 2.0 for Mac OS

Serial Number (5 digits): ________________________

First Name:     __________________________________

Last name:      __________________________________

Company:        __________________________________

Street Address: __________________________________

City:           __________________________________

State/Country:  __________________________________

Postal Code:    __________________________________

Telephone:     __________________________________

Fax:            __________________________________

E-mail:         __________________________________

Purchased From: _______________ Date: ____________
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16. Glossary

Adobe Illustrator 3

Tailor can export a document in the format used by Adobe Illustrator version 3.
Later versions of the Adobe Illustrator format are not supported.

See: User Guide, Converting PS and EPS files on page 30.

Adobe PhotoShop

Tailor can save a pixel image in a format compatible with Adobe PhotoShop.

See: User Guide, Setting export preferences for PhotoShop on page 59.

Adobe Type 1 font

See Type 1 font.

ASCII

A standard format for storing plain text, without formatting information.

See: User Guide, Converting PS and EPS files on page 30.

Bezier curve

A Bezier curve is used by PostScript to connect nodes in a path with a curved
line. Such a curve is described by the two endpoints and by two control points.
The position of those two control points determines how the curve actually
looks.

See: User Guide, Working with paths on page 41.
See: Reference Manual, Edit Paths Submenu on page 83.

Bounding box (PostScript)

This is a PostScript term for the smallest rectangle that encloses all elements of
a document or illustration.

See: User Guide, Understanding page size on page 71.

Bounding box (object)

The bounding box of an object is the smallest rectangle that can be drawn
around an object.

Cap

An attribute of a stroked path that indicates how the endpoints are drawn.
There are three kinds of caps: butt, round and square caps. The attribute is
shown in the Graphic Inspector.

See: User Guide, Working with paths on page 41.
See: User Guide, Viewing and editing object attributes on page 36.
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See: Reference Manual, Graphic Inspector on page 95.

Clip path

PostScript name for a mask.

CMYK

A color space consisting of the components Cyan, Magenta, Yellow and black
(K), the so-called process colors used in four-color printing.

Color Mixer

A floating panel that allows you to define a color using one of several color
spaces such as RGB, CMYK and spot color.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Color Mixer on page 105.

Color space

A way to define a color using a particular set of color components such as RGB
(Red, Green, Blue).

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Color Mixer on page 105.

Constrain

You can use the Option key to restrict rotation, scaling and shearing to par-
ticular increments. Press and hold the key before you start to drag.

See: User Guide, Moving, scaling, rotating and shearing visually on page 35.

Converter

The name of an AppleScript program shipped with Tailor to help automate con-
verting files from one format to another.

See: User Guide, Using Tailor Converter on page 68.

Document Inspector

A floating panel that displays information about your document.

See: Reference Manual, Document Inspector on page 103.

DSC

A set of conventions specified by Adobe for structuring PostScript and EPS files,
using comments that provide additional information, such as the number of
pages, the bounding box, etc.

See: User Guide, Understanding page size on page 71.
See: User Guide, Understanding font handling on page 61.

Document Structuring Conventions

See DSC.
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Embedded font

A font included in a PostScript file; Tailor can use embedded fonts.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Encapsulated PostScript

See EPS.

Enter a group

Tailor allows you to enter a group by double clicking one of its members, by
choosing Enter Group from the Edit menu or by clicking the Enter Group but-
ton on the Window Toolbar. You can then edit the group without disturbing the
rest of your document.

See: User Guide, Working with groups on page 43.
See: Reference Manual, Window Toolbar on page 92.

Eofill attribute

A fill attribute of a graphic path that specifies filling of the path using the even-
odd fill.

See: User Guide, Working with paths on page 41.
See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

EPS

A file format based on PostScript that is used for art or illustrations. Many pro-
grams allow placing EPS illustrations. An EPS file typically contains a preview
section that is used to display the illustration on the screen.

See: User Guide, Working with PS and EPS files on page 27.

EPSF header

An optional section of an Adobe Illustrator format file that defines the Illustra-
tor operation codes in function of PostScript operators. An Illustrator file with
EPSF header included can be used in other applications just like any EPS file.
For example, it can be opened in Tailor. An Illustrator file without EPSF header
can only be used with Illustrator (or applications that provide an import filter
for Illustrator format).

See: User Guide, Working with PS and EPS files on page 27.

Even-odd fill rule

A fill rule for paths (outlines). The rule determines whether a given point is at
the inside or the outside of the path. The point is inside the path if you cross the
path an odd number of times when moving to the point via a straight line.

See: User Guide, Working with paths on page 41.
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See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

Fill attribute

A fill attribute of a graphic path that specifies filling of the path using the non-
zero-winding fill rule.

Font Picker

A floating panel that allows you to select a font.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Font substitution

The replacement of a font specified in the PostScript file by a different font if
the original font is not available.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Format (file)

Tailor supports several file formats for import and export.

See: User Guide, Opening and saving documents on page 28.

GIF

a standard pixel image format used by many applications, especially in relation
to the Internet and the World Wide Web. Tailor can render a selection to GIF
format.

See: User Guide, Working with PS and EPS files on page 27.
See: User Guide, Converting PS and EPS files on page 30.

Glyph

The representation on paper (or screen) of a text character in a particular font.

See: User Guide, Working with character glyphs on page 39.

Graphic Interchange Format

See GIF.

Group-transparent selection tool

A special selection tool that allows you to select an object regardless of its
grouping.

See: User Guide, Working with groups on page 43.
See: User Guide, Selecting objects on page 33.
See: Reference Manual, Toolbox on page 93.



Tailor 2.0 � Reference Manual

127

Graphic Inspector

A floating panel that allows you to inspect and modify object attributes such as
color or font.

See: Reference Manual, Graphic Inspector on page 95.
See: User Guide, Viewing and editing object attributes on page 36.

Gray color space

A color space that represents only pure grays from black to white. Gray colors
are easily converted (without loss of precision) to both the RGB and CMYK color
spaces.

Group

A container object for a set of objects.

See: User Guide, Working with groups on page 43.

Group with mask

A group that contains a mask.

See: User Guide, Working with groups on page 43.
See: User Guide, Editing and creating masks on page 45.

Graphic state

The PostScript name for the set of graphical attributes such as color, font etc.
Tailor presents the elements of the graphic state in the Graphic Inspector.

See: Reference Manual, Graphic Inspector on page 95.
See: User Guide, Viewing and editing object attributes on page 36.

Import filter

A function in an application to convert files in a foreign format to the internal
data format of the application.

Join

An attribute of a stroked path that indicates how line connections are drawn.
There are three kinds of joins: round, beveled and mitered. The join attribute is
shown in the Graphic Inspector.

See: User Guide, Working with paths on page 41.
See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

LWZ compression

A compression technique used in PostScript level 2 and in several pixel image
formats, including GIF and TIFF.

See: User Guide, Setting export preferences for PS on page 51.
See: User Guide, Setting export preferences for TIFF on page 58.
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Mask

A path or outline used to limit the visible parts of other objects: only the parts
inside the mask are visible.

See: User Guide, Working with groups on page 43.
See: User Guide, Editing and creating masks on page 45.

Memory allocation

An amount of computer memory set aside for a particular application. To handle
complex or large documents, you need to enlarge Tailor�s memory allocation.

See: User Guide, Understanding memory management on page 75.

Miter limit

An attribute of a stroked path that indicates the maximum length of mitered
line joins. It limits the size of �spikes� when lines join at sharp angles. 1.415
cuts off miters at angles less than 90 degrees, 2.0 cuts off miters at angles less
than 60 degrees and 10.0 cuts off miters at angles less then 11 degrees.

See: User Guide, Editing and creating masks on page 45.
See: Reference Manual, Graphic Inspector on page 95.

Node

A path consists of a number of points or nodes that are connected with either
straight lines or Bezier curves.

Non-zero-winding fill rule

A fill rule for paths (outlines). The rule determines whether a given point is in-
side or outside of the path. The crossings with the path are counted when mov-
ing to the point along a straight line: add 1 for a left to right crossing, subtract 1
for a right to left crossing. The point is inside the path if the resulting number is
non-zero.

See: User Guide, Working with paths on page 41.
See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

Nudge

Nudging is moving an object one pixel at a time using the arrow keys. The ob-
ject is always moved by one pixel, regardless of the current magnification factor.
The closer you zoom in on an object, the more accurate you can nudge it.

See: User Guide, Viewing a document on page 32.
See: Reference Manual, Shortcut keys on page 89.

OPEN

A workflow management application developed by Luminous. Tailor can be
placed in an OPEN pipeline.
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See: User Guide, Placing Tailor in an OPEN pipeline on page 70.

OPI

(Open Pre-press Interface) A mechanism for referring to an external image file
from within a PostScript document, using structured comments.

See: User Guide, Working with OPI images on page 67.

Outlines

See Text line group.

Overprint

An attribute of an object specifying that the object should overprint its back-
ground instead of knocking it out. Overprints are used for print-technical rea-
sons, for instance to produce traps.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

Page

Tailor handles single page PostScript files as well as multi page files. You can
navigate easily between pages, or split a multi-page document in a number of
single-page files.

See User Guide, Viewing a document on page 32.
See User Guide, Using Tailor Converter on page 68.

Path

The PostScript name for an outline consisting of any mix of straight lines and
Bezier curves. A path can be filled or stroked.

See: Reference Manual, Edit Paths Submenu on page 83.
See: Reference Manual, Toolbox on page 93.

PDF

An object oriented portable document format specified by Adobe, based on the
PostScript imaging model. Tailor can export a document to PDF format.

See: User Guide, Converting PS and EPS files on page 30.

PICT

A pixel image format native to the Mac OS platform, mostly used for simple
bitmap representations. Tailor can include a PICT preview section in saved EPS
files, render a selection to PICT format, or paste a PICT into a document.

See: User Guide, Working with PS and EPS files on page 27.
See: User Guide, Opening and saving documents on page 28.
See: User Guide, Converting PS and EPS files on page 30.
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Point (measurement unit)

A unit of measurement used in the publishing world, mainly in relation to type.
A point is approx. 1/72 of an inch (1/72.27 of an inch to be exact).

See: Reference Manual, Preferences Panel on page 109.

PostScript

A page description language specified by Adobe.

See Getting Started, What is Tailor on page 7.

Portable Document Format

See PDF.

Preferences Panel

A floating panel that allows you to specify your preferences for Tailor�s user in-
terface and for import and export options.

See: User Guide, Setting preferences on page 49.
See: Reference Manual, Preferences Panel on page 109.

Preview mode

A display mode in which Tailor shows the document as it will print. See also
wireframe mode.

See: User Guide, Viewing a document on page 32.

Preview section

A section in an EPS file that contains a low-resolution image used for on-screen
preview purposes. Page-layout applications use this preview image (rather than
the PostScript data proper) to display the EPS on screen, avoiding the need for
a PostScript interpreter. Without preview image, the EPS is displayed as a gray
box.

See: User Guide, Working with PS and EPS files on page 27.
See: User Guide, Opening and saving documents on page 28.

Print file

A file produced using an application�s print command. You can edit a PostScript
print file with Tailor.

See: User Guide, Working with PS and EPS files on page 27.

Process color

A color printed by combining percentages from a fixed set of process inks such
as Cyan, Magenta, Yellow and Black (K). See also spot color.

Redo

The reverse action of Undo.
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Resolution

The number of dots per inch imaged by an output device, or the number of pix-
els per row and column in a pixel image.

See: User Guide, Setting import preferences on page 49.
See: User Guide, Setting export preferences for TIFF on page 58.

Rich Text Format

See RTF.

RGB

A color space consisting of the components Red, Green and Blue.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Color Mixer on page 105.

RTF

A file format to store formatted text understood by most popular word-
processors. Tailor can extract text from a PostScript file and save it in RTF for-
mat.

See: User Guide, Converting PS and EPS files on page 30.

Selection handles

A selected object is drawn with eight small rectangles positioned on the object�s
bounding box. You can click and drag these boxes to resize the selected object(s).
If you use the corner handles, Tailor preserves the aspect ratio. If you use the
middle handles, the object is distorted.

See: User Guide, Moving, scaling, rotating and shearing visually on page 35.

Selection rectangle

A rectangle that you drag to select all objects overlapping the rectangle.

See: User Guide, Selecting objects on page 33.
See: Getting Started, Frequently Asked Questions on page 22.

Separation

A separation contains the part of a color page that will be printed in a specific
ink. For example, a page to be printed in CMYK process color is separated in 4
layers or separations, one for each ink. Spot colors may add additional separa-
tions since each spot color is typically printed in its own specific ink.

Shortcut key

A keyboard alternative for a frequently used menu command.

See: Reference Manual, Shortcut keys on page 89.
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Spot color

A color printed by using an ink (or a tint of the ink) in that color. See also proc-
ess color.

See: User Guide, Working with spot colors on page 66.
See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Color Mixer on page 105.

Stroke attribute

An attribute of a graphic path that specifies stroking of the path, i.e. the path is
drawn using a �pen� with a thickness specified by the stroke width attribute.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

Structured comments

These are PostScript comments that follow Adobe�s Document Structuring Con-
ventions.

See DSC.

Styled Text

A format to store formatted text, specific to the Mac OS. It is the native format
of the SimpleText word processor.

Substitution (font)

See font substitution.

System font

A font installed on your computer.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Tagged Image File Format

See TIFF.

Tailor

The visual PostScript editor.

See: Getting Started, What is Tailor on page 7.

Text line group

A group of path objects that was created by Tailor as a result of converting text
to outlines.

See: User Guide, Understanding font handling on page 61.
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TIFF

A standard pixel image format used by many applications on many platforms.
Tailor can include a TIFF preview section in saved EPS files or render a selec-
tion to TIFF format.

See: User Guide, Working with PS and EPS files on page 27.
See: User Guide, Converting PS and EPS files on page 30.

Tint

The percentage of ink to be used in printing a color. Typically used in relation to
spot colors.

See: User Guide, Working with spot colors on page 66.
See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Color Mixer on page 105.

Toolbox

A floating panel that contains buttons representing tools for selection, view
scaling, drawing and transformation.

See: Reference Manual, Toolbox on page 93.

Tracking

The amount of extra space between characters or words. For Roman scripts the
vertical component is almost always zero.

See: Reference Manual, Graphic Inspector on page 95.

TrueType font

An information structure that describes a typeface (font) in a format specified
by Apple, and licensed by Microsoft. TrueType fonts can be installed on your
computer, or they can be embedded in a PostScript file (see Type 42 font). The
TrueType font format is not standard PostScript, but many modern PostScript
printers support it.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Type 1 font

An information structure that describes a typeface (font) in a format specified
by Adobe. Type 1 fonts can be installed on your computer, or they can be em-
bedded in a PostScript file. All PostScript printers support the Type 1 font for-
mat. Many high quality fonts are supplied in this format.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.
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Type 3 font

An information structure that describes a typeface (font) in a PostScript-specific
format. Type 3 fonts can not be installed on your computer; they are always em-
bedded in a PostScript file.

See: User Guide, Understanding font handling on page 61.

Type 42 font

An information structure that is used to embed a TrueType font in a PostScript
file.

See: User Guide, Understanding font handling on page 61.

Unavailable font

A font that is not available on your computer; Tailor uses another font instead.

See: User Guide, Understanding font handling on page 61.
See: Reference Manual, Font Picker on page 106.

Undo

A command to reverse the last action. Tailor provides multiple undo levels, set-
table in the Preferences Panel.

See: Reference Manual, Preferences Panel on page 109.

Uniform stroke

An attribute of a stroked path that indicates whether the stroke has a uniform
width or not. For a uniformly stroked path, the stroke width remains uniform
even when the path is scaled differently in horizontal and vertical directions.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.

Viewing scale

The magnification factor of the document view. The viewing scale is shown in
the Window Toolbar.

See: User Guide, Viewing a document on page 32.
See: Reference Manual, Window Toolbar on page 92.

Wildcard

A wildcard attribute means that the attribute is not the same for all selected
objects. Wildcard attributes are shown in the Graphic Inspector as a special
value (such as an asterisk) or by deselecting all of the corresponding attribute
buttons.

See: User Guide, Viewing and editing object attributes on page 36.
See: Reference Manual, Graphic Inspector on page 95.
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Window Toolbar

A row of buttons that appears at the bottom of every document window. It con-
tains controls for the viewing scale, wireframe mode, and group and page navi-
gation.

See: Reference Manual, Window Toolbar on page 92.

Wireframe mode

A display mode in which Tailor shows paths as thin lines instead of stroked or
filled shapes. See also preview mode.

See: User Guide, Viewing a document on page 32.

Zooming

The magnification or reduction of the viewing scale.

See: User Guide, Viewing a document on page 32.
See: User Guide, Understanding page size on page 71.


